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 About this Document

About this Document

Purpose

This manual provides information about installing, setting up, using and maintaining your 
D20MXTM Processor. This manual does not provide any procedures for configuring the 
software of the D20MX. 

Intended audience 

This manual is intended for use by field technicians and maintenance personnel who are 
responsible for the installation, upgrade, wiring and maintenance of SCADA equipment. 
This manual assumes that the user is experienced in: 

• Electrical utility applications

• Electrical wiring and safety procedures

• Related other manufacturers’ products, such as protective relays and 
communications equipment

Additional documentation 

For the most current version of the D20MX Hardware User's Manual, please download a 
copy from: http://www.gedigitalenergy.com/app/ViewFiles.aspx?prod=d20mx&type=3
For further information about the D20MX, refer to the following documents.

• SGConfigTM Online Help

• D20/D200 Installation and Operation Guide, 994-0078

• Application Configuration Guides and User Guides (available on the D20MX 
Documentation CD or extracted zip file.)

http://www.gedigitalenergy.com/app/ViewFiles.aspx?prod=d20mx&type=3
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How to use this manual 

This manual describes how to install the D20MX and get it up and running for the first time.
Procedures are provided for all component options available for the D20MX. The 
components included in your D20MX depend on what was ordered for your substation 
application. 
The software-related procedures in this manual are based on using a computer running 
Windows® XP. Some steps and dialog boxes may vary slightly if you are using another 
version of Windows.

Document conventions

The following typographic conventions are used throughout this manual:
Bold face is used for:

• Names of software program menus, editors, and dialog boxes; also for the names of 
menu commands, keyboard keys, icons and desktop shortcuts, and buttons and fields 
in editors and dialog boxes

• Names of hardware components

• User input that must be typed exactly

Italic face is used for:

• Emphasis

• Cross-references to sections, figures and tables within this manual and for titles of 
other documents

• File and directory names; examples of directory paths are generally given in the 
Windows format

• Placeholders for user input that is specific to the user. May also include angle brackets 
around the placeholder if the placeholder is already in italic text. For example, 
c:\<product>\product.def

• References to a parameter or field value shown
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Safety words and definitions

Before attempting to install or use the device, review all safety indicators in this document 
to help prevent injury, equipment damage or downtime.
The following safety and equipment symbols are used in this document:

Indicates a hazardous situation which, if not avoided, results in death or serious injury. 

Indicates a hazardous situation which, if not avoided, could result in death or serious 
injury. 

Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

Indicates practices that are not related to personal injury.
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Product Support

If you need help with any aspect of your GE Digital Energy product, you have a few options.

Search technical support  

The GE Digital Energy Web site provides fast access to technical information, such as 
manuals, release notes and knowledge base topics at:

http://www.gedigitalenergy.com

Contact customer support  

The GE Digital Energy Customer Service Center is open 24 hours a day, seven days a week 
for you to talk directly to a GE representative.
In the U.S. and Canada, call toll-free: 1 800-547-8629
International customers, please call: + 1 905-927-7070
Or e-mail to multilin.tech@ge.com
Have the following information ready to give to Customer Service:

• Ship to address (the address that the product is to be returned to)

• Bill to address (the address that the invoice is to be sent to)

• Contact name 

• Contact phone number 

• Contact fax number 

• Contact e-mail address 

• Product number / serial number

• Description of problem

The Customer Service centre provides you with a case number for your reference.

http://www.gedigitalenergy.com
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Product returns

A Return Merchandise Authorization (RMA) number must accompany all equipment being 
returned for repair, servicing, or for any other reason. Before you return a product, please 
contact GE Digital Energy to obtain an RMA number and instructions for return shipments. 
You are sent the RMA number and RMA documents via fax or e-mail. Once you receive the 
RMA documents, attach them to the outside of the shipping package and ship to GE.

NOTE

Product returns are not accepted unless accompanied by the Return Merchandise 
Authorization number.

Upgrade your D20MX processor firmware

The firmware of your D20MX Processor can be upgraded to provide the latest functionality 
and improvements. 
Go to the D20MX Substation Controller web page at http://www.gedigitalenergy.com/app/
ViewFiles.aspx?prod=d20mx&type=7 to download the upgrade software.
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Chapter 1: Before You Start

Before You Start

The D20MX Substation Gateway is a specialized computing platform which executes 
communications and energy management applications for monitoring and control of 
electrical substations. The D20MX is capable of consolidating data from multiple slave 
devices connected through communication channels (DCA: Data Collection Applications) 
and D20 Input / Output Modules in a single database. The D20MX can execute local logic, 
aggregate data, process data through one of multiple applications (DTA: Data Translation 
Applications) and report data upstream to master stations through different server 
protocols (DPA: Data Processing Applications). 
The new D20MX processor card is a pin-for-pin compatible replacement for all generations 
of the D20 SBC, providing the latest revisions of common D20 applications and 
performance enhancements to support NERC-compliant Cyber security. 
Before you begin installing and using the D20MX, review the information in this chapter, 
including the following topics:

• Safety precautions

• Regulatory compliance information 

• Product overview

• Product specifications

• Storage recommendations

Read and thoroughly understand this manual before installing and operating the unit. 
Save these instructions for later use and reference.

WARNING! Failure to observe the instructions in this manual may result in serious 
injury or death.

Safety precautions 

Follow all safety precautions and instructions in this manual.
Only qualified personnel should work on the D20MX. Maintenance personnel should be 
familiar with the technology and the hazards associated with electrical equipment.

• Never work alone.
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• Before performing visual inspections, tests, or maintenance on this equipment, isolate 
or disconnect all hazardous live circuits and sources of electric power. Assume that all 
circuits are live until they have been completely de-energized, tested, and tagged. Pay 
particular attention to the design of the power system. Consider all sources of power, 
including the possibility of back feed.

• Turn off all power supplying the equipment in which the D20MX is to be installed 
before installing and wiring the D20MX.

• Operate only from the power source specified on the installed power supply module.

• Beware of potential hazards and wear personal protective equipment.

• The successful operation of this equipment depends upon proper handling, 
installation, and operation. Neglecting fundamental installation requirements may 
lead to personal injury as well as damage to electrical equipment or other property.

• All AC voltage terminals are protected from accidental contact by a mechanical safety 
shield. 

• All electronic components within the D20MX are susceptible to damage from 
electrostatic discharge. To prevent damage when handling this product use approved 
static control procedures.

• Hazardous voltages can cause shock, burns or death. To prevent exposure to 
hazardous voltages, disconnect and lock out all power sources before servicing and 
removing components.

• If the D20MX is used in a manner not specified in this manual, the protection provided 
by the equipment may be impaired.

• Changes or modifications made to the unit not authorized by GE Digital Energy could 
void the warranty.

Warning symbols 
Table 1 explains the meaning of warning symbols that may appear on the D20MX.

Table 1: Warning symbols  

Symbol Description

The relevant circuit is direct current.

The relevant circuit is alternating current.

Caution:   Refer to the documentation for important operation and 
maintenance instructions. Failure to take or avoid specified actions could 
result in loss of data or physical damage. 

Warning:   Dangerous voltage constituting risk of electric shock is present 
within the unit . Failure to take or avoid specified actions could result in 
physical harm to the user. 

Earth/Ground Terminal

Protective Ground Terminal

Caution: Hot Surface

!
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Regulatory compliance information 

CE Mark compliance
The D20MX is rated as CISPR 11 Group 1 Class “A” equipment.
To meet essential safety requirements of the LV Directive 2006/95/EC, the D20 chassis 
must be installed in a secondary cabinet if an operating voltage on any of the terminals is 
equal to or higher than 50 VAC or 75 VDC. Proper wiring practices and applicable local 
safety standards defining protection against electrical shock must be followed at all times. 

NOTE

To provide higher EMC immunity and maintain CE Mark compliance, the serial cables used 
for permanent RS-232 and RS-485 connections must comply with the following 
requirements:

• Cables must be shielded

• D type connector covers must provide EMC shielding (e.g., metallized plastic or die 
cast metal covers) for permanently connected RS-232 cables

Class “A” equipment is intended for use in an industrial environment. The equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with these instructions, may cause interference to other devices in the vicinity. 
If this equipment does cause interference with other devices, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures:
• Reorient or relocate the receiving device
• Increase the separation between the equipment
• Connect the equipment into an outlet on a circuit different from that to which the 

other device(s) is connected
• Consult the manufacturer or field service technician for help

Product overview

The D20 is a standalone remote terminal unit (RTU). It consists of a D20MX processor 
board, power supply, optional termination panels, and optional communications 
equipment in a 3U tall, 19-inch wide chassis. These components, combined with software 
applications running on the D20MX, form the D20 RTU System.
The D20 acts as a data concentrator and central processor. Field data gathered through 
the peripheral modules and external Intelligent Electronic Devices (IEDs) are stored in the 
system database and can be accessed by the application programs loaded on the D20.

Product design
The D20 design has horizontally mounted processor boards, with multiple boards in some 
versions.
Peripheral I/O boards operate independently of the main chassis and D20MX processor 
board. This means that you can use a D20 without direct connection to peripheral boards 
so that it acts as a master data concentrator to other RTUs. You can also hot-swap the 
peripherals without powering down the main processor. For information on peripheral 
modules, see the D20/D200 Installation and Operations Guide (part number 994-0078); see 
section: Connections and Configuration.
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D20MX Processor 
The D20MX is a single board computer built around a 667 MHz embedded PowerQUICC II 
Pro processor. The D20MX supports open standard cyber security features that allow 
interoperability in NERC CIP environments and introduces compliance to IEC standards; 
refer to Appendix A, Standards & Protection for the complete listing.
The D20MX can be retrofitted into either a D20 3U single-node VME chassis or D20 3U non-
VME chassis. In a single-node VME chassis, this one processor module replaces the 
previous D20 M, M++, ME, and MEII CPU cards.
Due to aging printed circuit board assembly and mechanical constraints, only certain 
chassis from 2002 and onward can be used with a D20MX. This comprises the following 
chassis:

• D20 VME chassis 500-0280 Release 08 or higher, 

• D20 Non-VME chassis 500-0305 Release 18 or higher 

A solid partition between the Main processor bay and accessory bay prevents access to 
the harness from the fiber card to D20MX card (only applicable to the 526-3005LF fiber 
card version).

Security
The D20MX provides the following new security improvements over its predecessors:

• Centralized user authentication and authorization (RADIUS), including integration with 
Microsoft Servers using NPS

• Role Based Access Control (RBAC) keeping operator and engineering activities 
separated, logged and simple

• NERC compliant passwords, with strong complexity rules and one-way encrypted

• Full auditing including Syslog integration to enterprise systems 

• SFTP for secure network-based firmware upgrades and configuration file transfers 

• SSH for secure network access to WESMAINT II+. and the LogicLinx Executor. Refer to 
Appendix E: “Secure Connection for LogicLinx” on page 145 for details on securing 
network access to the LogicLinx Executor.

To take advantage of these improvements, refer to the WESMAINT II+ for the D20MX 
Configuration Guide (B014-1NCG) for details of these security features of the D20MX.

CyberArk A plug-in available from CyberArk Software Ltd. enables the D20MX to be integrated with 
the CyberArk Privileged Identity Management (PIM) Suite. In addition to centralized user 
authentication and authorization, integration with CyberArk, PIM provides a one-time 
password model for the D20MX. 
Contact CyberArk (http://cyberark.com) for details.
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D20MX applications 
Table 2 lists the applications included in the D20MX firmware. 

NOTE

*   An Application ID containing an “N” (e.g., A009N) signifies a unique application definition 
for the D20MX. 

†   The D20MX version of the application is based on this D20 classic application version. 
However, the D20MX version is not identical to the D20 classic version due to minor 
changes to improve the robustness and security of the original application.

‡   The version of B009 in SAN0002 is actually based on D20 classic application version 401 
but modified to be compatible with the version 310 application definition version.

Ф   The version of B021 in SAN002 is actually based on D20 classic application version 991 
but modified to be compatible with the version 912 application definition version.

Table 2:  D20MX applications

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description

Common Application Definitions

001 A009N 805 PG&E DPA for D20MX Pacific Gas and Electric (PG&E) data-processing 
application (DPA) for remote terminal units 
(RTUs).

001 A017N 131 Distributed Network 
Protocol V1.00 DCA for 
D20MX

Distributed Network 
Protocol (DNP) V1.0 Data Link Application. 
Required by the Quantum Meter Scanner DCA.

001 A018 120 Quantum Meter Scanner 
DCA

The Quantum Meter Scanner DCA obtains data 
from one or more Quantum Meters via the DNP 
interface. 

001 A023N 423 CDC Type I DPA for D20MX The CDC Type I DPA emulates a CDC Type I RTU

A026-1 321 Communication 
Watchdog DTA

Reports on the state of communications 
between the RTU and a remote device (Data 
Translation Application). 

A027N 832 SOE Logger DTA for D20MX The Sequence-of-Events Logger DTA processes 
sequence of events (SOEs) from any sub-set of 
the system digital input and/or analog input 
points.

A030 300 Accumulator Freeze DTA Detects system status point changes and 
system accumulator point freezes.

001 A033-5N 211 TEJAS V DPA for D20MX Emulates a remote terminal unit utilizing the 
(Valmet/Metso/Telvent) TEJAS V 
communication protocol.

A035 211 Analog Reference DTA Monitors analog input points and provides the 
system database with pseudo analog values 
that represent either correctly functioning 
analog input hardware (good reference value), 
or failed analog input hardware (bad reference 
value).

001 A036N 421 ProLogic Executor DTA for 
D20MX

Provides user programmable soft logic 
automation functionality.

001 A041-1 116 Proportional Integral 
Derivative Control DTA               

The Proportional, Integral and Derivative (PID) 
DTA uses the generally-accepted industry 
standard for control of closed loop processes. 

A059-0N 911 Modbus DCA for D20MX Acts as a data concentrator for one or more 
Sub-Remote Units (SRUs) using the MODBUS 
communication protocol (RTU & ASCII modes).

A068N 311 Modbus DPA Capable of communicating with one or more 
master stations using the MODBUS protocol 
(RTU & ASCII modes).
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A078N 610 SEL Gateway DCA for 
D20MX

A sub-master within a SCADA system, 
controlling SEL relay equipment using SEL's 
ASCII character-based relay protocol

A083-0 342 Calculator DTA Convenient and flexible soft logic utility that 
can perform applications such as substation 
level interlocking, feeder interlocking, and 
converting digital inputs to control outputs for 
driving a map board

A088-0 203 Substation Maintenance 
DTA 

Allows status and analog input values to be 
suppressed for maintenance purposes.

A101-0N 906 IEC 870-5-101 DPA for 
D20MX

Communicate with one or more hosts using the 
IEC 60870-5-101/104 (T101) protocol. Has the 
ability to function as several distinct IEC 60870-
5-101/104 RTUs. Supports the unbalanced 
version of the data link.

001 A113N 301 PSR DCA for D20MX Programmable Synchrocheck Relay (PSR) DCA 
acts as a data concentrator for several remote 
PSRs. The DCA and remote PSRs function as a 
remote synchronous closure controller. 

A118 103 Failover DTA Allows configurable combination of control 
requests to result in a failover or switchover of 
a redundant system.

A123-0 111 NGC General DTA Generates control lockout indications, digital 
input suppression or unsupression indications, 
and control active indications.

A131-0 131 MODBUS TCP/IP DCA Provides an interface to Sub-Remote Units 
(SRUs) using the MODBUS protocol over the 
TCP/IP communication layer.

A135-0 110 MODBUS TCP/IP DPA Provides communications with one or more 
master station using the MODBUS protocol 
over TCP/IP communication layer.

A184-0 120 General Alarm DTA Takes several alarms and groups them 
together under one General Alarm.

001 A185-0N 303 W18979 DPA for D20MX Emulates the Landis & Gyr 8979 RTU. 
Communicates with multiple master stations, 
over redundant communication lines. 

A195-0 110 Redundant I/O DTA Provides I/O point redundancy.

001 A199-0N 106 HR6000/XA-21 (DPA) for 
D20MX

Communicates with one or more hosts using 
the Harris HR6000/XA-21 protocol, emulating 
several HR6000/XA-21 LRUs. Supports multiple 
communication ports, multiple LRUs per 
communication port, and redundant porting. 

B003 751 D.20 Peripheral Link DCA The D.20 Peripheral Link is responsible for 
surveillance and control of digital and analog 
values in the D.20 I/O peripherals.

B008-1 311 System Point Database Maintains the database of system points in the 
RTU.

B012N 201 IRIG-B DCA for D20MX Provides Universal Time Coordination (UTC) 
using the IRIG-B pulse frame, as specified by 
IRIG Standard 200-04 September 2004 Edition.

B013 560 DNP V3.00 Data Link Provides services for software applications to 
send and receive messages using the 
Distributed Network Protocol (DNP) V3.00 Data 
Link protocol and the DNP V3.00 Transport 
Functions

B014-1N 520 WESMAINT II+ for D20MX RTU maintenance facility. 

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description
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B015 530 Bridgeman Allows applications to communicate with other 
peer applications. Automatically routing 
messages to the destination application. 
Intended to work within layered software 
architectures. Provides the routing functions of 
a network layer, but does not add a network 
layer header to outgoing messages. 

B023 755 DNP V3.00 DCA The Distributed Network Protocol V3.00 DCA 
acts as the master to one or more remote 
devices using the DNP V3.00 protocol.

B034N 203 Redundant Monitor for 
D20MX

Monitors CCU states and initiates failover. Also, 
receives command requests to perform 
database synchronization, switchover and 
failover.

B045-0 101 D20AC WESMAINT II+ 
Display Screens

Provides D20AC WESMAINT II+ displays

B052-0N 351 DNP Internet Data Link for 
D20MX

DNP V3.00 data link over internet

B058-0N 231 IEC 870-5 Data Link for 
D20MX

FT 1.2 primary data link configuration

B060-0 210 IEC 870-5-101 DCA Acts as a master (primary) communication 
device, initiating data exchanges. It is capable 
of sending control commands to the remote 
devices, and processing data autonomously 
collected by the data link layer. 

B071-0 200 WESMAINT File Upload Uploads files via the WESMAINT port as S 
records or using ZMODEM.

002 B082-0N 311 LogicLinx Executor WARP 
for D20MX (Ethernet 
capable)

The LogicLinx executor is responsible for 
executing PLC programs written using the 
LogicLinx PLC (IEC 1131-3 compliant) editor.

B085-0 130 IEC Balanced Data Link Provides services to send and receive 
messages using the IEC 60870-5 FT 1.2 
Balanced Protocol over point-to-point links, 
with support for a dial-up modem. Works with 
one user in point-to-point configurations, or 
multiple users in dial-up configurations. 

B086-0 131 IEC 60870-5-104 Data Link Provides a service to reliably transfer IEC 
60870-5-101 Application Service Data Units 
(ASDU) over a TCP/IP network. Implements this 
service using the transport layer interface 
protocol IEC 60870-5-104. 

B099-0 113 SNTP Client DTA The Simple Network Time Protocol (SNTP) client 
application provides reasonably accurate and 
reliable time synchronization.

B100-0 141 Internet Protocol Stack Configuration of the LAN

B148-0 104 Time Zone and DST 
Settings DTA

The Time Zone and DST (Daylight Saving Time) 
provides a time zone and DST information to 
other applications.

B152-1N n/a IP Redundancy Monitor 
DTA for D20MX

Provides health and active pseudo DI points for 
LAN Ports.

SAN0001 Applications

B009 401 Mailbox DTA System point conversion application.

B021N 991 DNP V3.00 DPA for D20MX The Distributed Network Protocol (DNP) DPA 
enables master stations to retrieve and modify 
local data using the DNP V3.00 Application 
Layer Protocol.

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description
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Table 3 provides the License Group legend.

Table 3: D20MX license group

NOTE

The license group is an option in the D20MX order code. Refer to Table 9 and Table 10 for 
details. Ordering a D20MX with a particular license group option enables all applications in 
that group to run on the D20MX. 

Table 4 lists the embedded images included in the D20MX firmware.
The Version Image column indicates the image versions in the SAN0001 and SAN0002 
files.

Table 4: D20MX embedded images

Firmware/FPGA versions
Table 5 lists the firmware, FPGA and other version information. 

Table 5: Firmware/FPGA versions information

SAN0002 Applications

B009 310‡ Mailbox DTA Same application as used in SAN0001 except it 
allows you to avoid manually correcting some 
configuration warnings after transferring D20 
firmware containing B009 versions less than or 
equal to 310.

B021N 912 Ф DNP V3.00 DPA for D20MX Same application as used in SAN0001 except it 
allows you to avoid manually correcting some 
configuration warnings after transferring D20 
firmware containing B021 versions less than or 
equal to 912.

License 
Group

D20MX 
Application ID

Base D20 Classic 
Application Version †

Application Name Description

LIcense Group Group Description

001 D2X Classic Applications

002 Advanced Automation Applications

Image 
ID

Image Name Description Version 
Image

S032 D20S Peripheral Board (supports B003) D20S Peripheral Board Code 303

S033 D20A Peripheral Board (supports B003) D20A Peripheral Board Code 301

S034 D20K Peripheral Board (supports B003) D20K Peripheral Board Code 306

S035 D20C Peripheral Board (supports B003) D20C Peripheral Board Code 307

S055-0 D20AC Peripheral Board (supports B003) D20AC Peripheral Board Code 108

Component Version ID Type ID Date How to Find

JMON 1.0.630-
2238

N/A N/A Wed Dec 12, 
2012 11:06AM

“D20 Version” shown 
during cold boot 
sequence.

Board N/A Board D20MX N/A “Board ID” shown via 
SHELL command: si

Local Bus 
FPGA 

3.04 N/A N/A N/A “FPGA version” shown via 
SHELL command: si

NVRAM FPGA 15 File N/A N/A “NVRAM Rev” shown via 
SHELL command: si

VxWorks O/S 
and BSP

v1.3/0 Build 8772079f80b6c4b5                           Dec 16 2013, 
20:20:41

SHELL command: img

Application v1.32 Build d734740d1e3e44cf        May 5 2014 - 
23:30:59

SHELL command: img
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D20 chassis
For a detailed description of the D20 chassis options and components, refer to the 
Familiarization chapter in the D20/D200 Installation and Operation Guide, 994-0078. The 
D20MX supports the two versions of the D20 chassis listed in Table 6. 

Table 6: Types of D20 chassis

D20 non-VME The D20 non-VME single-slot chassis consists of the following:

• D20MX processor board

• Modem slots

• Power supply with switch and fuses; see Figure 1.

Figure 1: D20 non-VME chassis - power supply switch and fuses 

This chassis contains the WESTERM D20M+ SS termination panel, which is attached 
directly to the back of the assembly; see Figure 2.

Bootrom v1.1/0 Build 55959fd4c8a2db7f Mar 11 2013 
15:50:15

SHELL command: img

Component Version ID Type ID Date How to Find

Type GE part number Description

D20 non-VME 
1 slot horizontal

500-0305 Chassis with backplane, external power connections, and 
seven serial I/O ports

D20 VME 
5 slot horizontal

500-0280 Chassis with five-card VME backplane

D20 non-VME Chassis

Power Supply Switch

Power Supply Fuses
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Figure 2: D20 non-VME backplane 

D20 VME The D20 VME-compatible chassis (see Figure 3) can support one D20MX main board. When 
using the D20MX in a VME chassis, the 0 V ground wire must be used. 

Figure 3: D20 VME chassis - power supply switch and fuses 

This chassis (see Figure 4) contains the WESTERM D20M+ termination panel that is 
mounted separately on the D20 chassis. The VME chassis kit includes a VME bus 
backplane, called the WESTERM D20VME. The VME bus backplane connects to the 
termination panel using a ribbon cable from Slot 1 on the bus backplane. 

D20 Non-VME Chassis

Power Supply 
Connector Block

WESTERM D20M+ 
SS Termination Panel

D20 VME Chassis

Power Supply Switch

Power Supply Fuses
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Figure 4: D20 VME chassis - VME bus backplane and D20M+ termination panel 

Power supply
The chassis-mounted power supply modules are switch-mode converters that provide 
output power for the D20MX processor board, VME cards, modems and D20 Peripheral I/O 
modules, as required. A redundant power supply can be installed to provide fail-over 
protection to ensure continuous power to the D20.
If you have an extended system with more than five peripherals, the chassis-mounted D20 
power supply is not adequate. In this case, you need to install an external power supply.
Table 7 lists the standard power supplies that are available. Other power supplies are 
available for specific requirements. Contact GE Digital Energy for details.

Table 7: Available power supplies

Ensure your D20 power input is externally protected for over-current; otherwise damage to 
the D20MX may occur. The required fuse rating depends on the power consumption of 
your system.

The D20 available power supplies, listed in Table 7 are equipped with two field replaceable 
fuses.; see Figure 5.

D20 VME Chassis

WESTERM D20VME - 
VME Bus Backplane

WESTERM D20M+ 
Termination Panel

GE part number Input Output

580-2004 20 to 60 V DC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 24 V DC, 3 A

580-2005 20 to 60 V DC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 48 V DC, 1.5 A

580-2006 100 to 300 V DC or 85 to 264 V AC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 24 V DC, 3 A

580-2007 100 to 300 V DC or 85 to 264 V AC +5 V, 7 A; +12 V, 2 A; -12 V, 1 A; 48 V DC, 1.5 A
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Figure 5: D20 - Location of field-replaceable fuses 

Field-replaceable fuses for the standard chassis-mounted Power Supplies are listed in 
Table 8. These are the standard factory-installed fuses, unless otherwise specified. Always 
replace with the same type and values of fuse.

Table 8: Field-replaceable fuses

Modems
D20 modems (can be purchased separately) for communications to a host computer or to 
other IEDs. 
For example, WESDAC 202/V.23 is a 1200-baud Bell 202 or CCITT V.23 standard modem 
designed for 300 to 1200 baud asynchronous operation on unconditioned lines and 
supports the majority of SCADA/EMS applications. It is available in a 3U (GE part number 
520-0120) vertical mount configuration in the D20 chassis; the 19 inch rack mount (GE part 
number 520-0090) version is currently not supported.
Third-party modems can be used to meet specific requirements. These modems are 
connected to the D20 via standard RS-232 connections. Contact GE Digital Energy for 
more information on options.

Power Supply Fuse Fuse Function Replacement Fuse
(¼inch by 1 ¼ inch Time Delay)

580 - 2004 F1 +DC Input 12 A / 250 V

F2 -DC Input 12 A / 250 V

580 - 2005 F1 +DC Input 12 A / 250 V

F2 -DC Input 12 A / 250 V

580 - 2006 F1 Line/+DC Input 4 A / 250 V

F2 Neutral/-DC Input 4 A / 250 V

580 - 2007 F1 Line/+DC Input 4 A / 250 V

F2 Neutral/-DC Input 4 A / 250 V

Field-replaceable
fuses
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Ordering guide

The latest D20MX Processor ordering guide is available on the GE Digital Energy website:
http://www.gedigitalenergy.com/multilin/energy/catalog/D20MX.htm

You can select the required options from the available Product Option items. The Order 
Code automatically updates as each option is selected.
The Order Codes are listed in Table 9.

Table 9: D20MX order codes

D20 MX CPU Options D20 MX -* * * * * * * * * U U

(A) - D20MX non-VME, dual 10/100/1000BASE-TX Ethernet Ports (front 
access)

A

(C) - D20MX non-VME dual 100BASE-FX Ethernet Ports (front access) C

(G) - D20MX non-VME, dual 100BASE-FX Ethernet Ports (rear access) G

D20 MX CPU Options

(U) - Not required U

(A) - D20 Power Supply, 20-60VDC Input, 24V ISO Output A

(B) - D20 Power Supply, 20-60VDC Input, 48V ISO Output B

(C) - D20 Power Supply, 100-300VDC/85-264VAC Input, 24V ISO Output C

(D) - D20 Power Supply, 100-300VDC/85-264VAC Input, 48V ISO Output D

D20MX Modem slots 1, 2 & 3

(U) - Empty slot with cover plate U U U

(A) - Wesdac D20 202 bin modem A A A

(C) - Telenetics 14400 baud modem 2-wire dial up C C C

(D) - Telenetics 14400 baud modem 4-wire leased line D D D

(E) - D20MX dual 100BASE-FX ST Media Interface Card E

(F) - D20MX dual 100 BASE-FX LC Media Interface Card F

D20MX Serial Termination Panel Options 

(A) - 19" Rack Mount Serial IO Westerm Panel A

(B) - D20 Chassis Mounted Serial IO Westerm Panel B

(C) - D20 Chassis Mounted Serial IO Westerm Panel w/Extended Bracket C

D20MX firmware options

(E) -D20MX firmware v1.32 E

D20MX D2X CLASSIC APPLICATIONS License

(U) - Not required U

(A) - D2X CLASSIC APPLICATIONS A

D20MX D2X ADVANCED AUTOMATION APPLICATIONS License

(U) - Not required U

(B) - D2X ADVANCED AUTOMATION APPLICATIONS B

FUTURE Feature

(U) - Not required U

FUTURE Feature

(U) - Not required U
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D20MX upgrade kits

Table 10 provides the available D20MX upgrade kits and spare kit (D20MX CPU only) Order 
Guide. Order GE part number 588-0082: SGConfig Setup Software DVD if required.

Table 10: D20MX upgrade kits order guide

D20MX Kit Type D20MXK -* * * * * * U U

(A) - Upgrade Kit for D20 Horizontal chassis A

(C) - D20MX CPU only C

D20MX CPU Options

(A) - D20MX non-VME, dual 10/100/1000BASE-TX Ethernet Ports (front access) A

(C) - D20MX non-VME dual 100BASE-FX Ethernet Ports (front access) C

(G) - D20MX non-VME, dual 100BASE-FX Ethernet Ports (rear access) G

D20MX Media Interface Card Options

(U) - Not required U

(E) - D20MX dual 100BASE-FX ST Media Interface Card E

(F) - D20MX dual 100 BASE-FX LC Media Interface Card F

D20MX firmware options

(E) -D20MX firmware v1.32 E

D20MX D2X CLASSIC APPLICATIONS License

(U) - Not required U

(A) - D2X CLASSIC APPLICATIONS A

D20MX D2X ADVANCED AUTOMATION APPLICATIONS License

(U) - Not required U

(B) - D2X ADVANCED AUTOMATION APPLICATIONS B

FUTURE Feature

(U) - Not required U

FUTURE Feature

(U) - Not required U
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Table 11 lists the parts provided in each D20MX upgrade kit. 

Table 11: Upgrade kit parts

Table 12 lists the parts provided in each D20MX spare kit.

Table 12: Spare kit parts

Part Number Part Description D
20

M
XK

-A
A

U
XX

U
U

U

D
20

M
XK

-A
C

U
XX

U
U

U

D
20

M
XK

-A
G

EX
XU

U
U

D
20

M
XK

-A
G

FX
XU

U
U

526-3001 D20MX CPU non VME 2x10/100/1000 BaseTX 1    

526-3003 D20MX CPU non VME 2x100 BaseFX (Front Access)  1   

526-3005 D20MX CPU non VME 2x100 BaseFX (Rear Access)   1 1

526-3103LF D20MX 100Base-FX Rear LC FO Card    1

526-3104LF D20MX 100Base-FX Rear ST FO Card   1  

975-1236 D20MX CPU to D20MX Rear FO Card Harness   1 1

975-1237 Termination panel to Backplane 0 V Harness  1  1 1 1

953-1014 Blank Plate for D20MX Install  1  1 1 1

953-1015 Lower filler cover plate  1  1 1 1

581-0002 GE Digital Energy Products Documentation CD  1  1 1 1

588-0075 V1XX GE Digital Energy D20MX Documentation CD  1  1 1 1

977-0529/72 Cable, Null Modem DB9F-DB9F, 80 °C, 150 V  1  1 1 1

460-0073 Ferrite clamp  1  1 1 1

Part Number Part Description D
20

M
XK

-C
A

U
XX

U
U

U

D
20

M
XK

-C
C

U
XX

U
U

U

D
20

M
XK

-C
G

EX
XU

U
U

D
20

M
XK

-C
G

FX
XU

U
U

526-3001 D20MX CPU non VME 2x10/100/1000 BaseTX 1    

526-3003 D20MX CPU non VME 2x100 BaseFX (Front Access)  1   

526-3005 D20MX CPU non VME 2x100 BaseFX (Rear Access)   1 1

526-3103LF D20MX 100Base-FX Rear LC FO Card    1

526-3104LF D20MX 100Base-FX Rear ST FO Card   1  
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Product specifications 

The D20MX adheres to the following system, communications, electrical, physical and 
environmental specifications. Additional Standards and Protection are listed in Appendix A, 
Standards & Protection.

System

Communications

Electrical

Processor 667 MHz embedded PowerQUICC II Pro

Memory 1024 MB of 266 MHz DDR2 RAM with ECC
16 MB NVRAM for persistent event storage

Storage 8 MB boot flash
256 MB firmware flash

Operating system VxWorks

LED indicators System status: Power, Ready
Ethernet port status: Link and Activity status per port
Power supply: Power
IRIG: Flashes when active.

Network connections Dual redundant Ethernet interface
Twisted Pair
10/100/1000BaseT (Isolated RJ-45 connector)
100BaseFX (Fiber Optic: 1300 nm, 50/125 µm, 62.5/125 µm multi-mode 
duplex fiber cable, ST connectors)

Serial communications D.20 Link, 2 channels
Data rate: 250 kbps
Surge protected to ±2000 V peak

RS-232, 7 channels
5-signal (TXD, RXD, RTS#, CTS#, DCD#) DTE ports
Data rate: independently-selectable; refer to the application configuration 
guides.

Maintenance Port RS-232, 1 channel/ 2 ports
2-signal (TXD, RXD)
Data rate: 19200 (default)

Rated power supplies AC-DC 100 to 240 V AC (±10%) 143 W output maximum
Minimum/Maximum AC voltage: 90 V AC / 265 V AC
100 to 300 V DC (±10%) 143 W output maximum
Minimum/Maximum DC voltage: 88 V DC / 330 V DC

DC-DC 20 to 55 V DC (±10%) 135 W maximum
Minimum/Maximum DC voltage: 18 V DC / 60 V DC

Peak inrush current at 
25 °C on cold start

AC-DC 50 A, max at 230 V AC

DC-DC 50 A, max at 230 V AC

Rated frequency 
(AC-DC)

50/60 Hz nominal (47 to 63 Hz)
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Physical

Environmental

Software

Overall height 40.34 mm (1.588 in.)

Width 261.87 mm (10.31 in.)

Depth 160 mm (6.3 in.)

D20MX weight 0.7 kg (1.65 lb)

Fiber card weight 0.2 kg (0.35 lb)

Battery shipping 
restrictions

The D20MX does not contain a battery and is therefore not affected by 
US DOT or ICAO shipping restrictions.

Material/Finish Galvannealed steel with black power coat

Kit package Length:   49.5 cm (19.5 in.)
Width:     34.3 cm (13.5 in.)
Height:    15.2 cm (6 in.)
Weight:   2.54 kg (5.6 lb)

Operating temperature 0°C to +70°C
Note: Do not operate the D20MX above 60°C for extended periods of 
time as this shortens the life of the super capacitor and reduces the 
backup time of the real time clock.

Humidity rating 5% to 95% relative humidity, non-condensing 

Environmental rating Ingress protection: IP30 (IEC 60529)

Installation / 
overvoltage category

CAT II (2)

Pollution degree 2

Use Indoor use only

Operating altitude Maximum altitude 3000 m [9480 feet] above sea level

MTBF (MIL-HDBK-217): 
D20MX processor board

Non-VME with 10/100/1000BASE-TX copper: 449,616 hours at 40°C
Non-VME with 100BASE-FX fiber optic: 265,657 hours at 40°C

Configuration Performed using SGConfig 7.2 and higher
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Storage recommendations

Storage conditions 
Always store the D20MX in an environment compatible with operating conditions. 
Recommended environmental conditions for storage are:

• Temperature: -40 °C to +85 °C

• Relative humidity: 5% to 95%, non-condensing

• Maximum altitude: 12192 m [40,000 feet] above sea level

NOTE

Do not store the D20MX above 60°C for extended periods of time as this shortens the life of 
the super capacitor and reduces the backup time of the real time clock.

When powered off, the D20MX real time clock remains active for 14 days at -40°C to 60°C, 
and greater than one month at 25°C. Information in the NVRAM remains stored indefinitely 
since flash memory is used.
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D20MX Processor

Chapter 2: Connecting to Devices 
and Networks

Connecting to Devices and Networks

This chapter provides guidelines for making physical connections between the D20 and 
substation and network devices.

Cabling overview

All physical connections are made to the connectors on the rear backplane of the D20 
chassis or to the front on the D20MX processor module.

D20MX front panel connectors
The D20MX front panel can have one of the following layouts: 

• Ethernet connectors (RJ45); see Figure 6.

• Front access Fiber optic connectors (ST); see Figure 7.

• Rear access Fiber optic connectors on a fiber optic daughter card; see Figure 8. The 
optic daughter card can be either a D20MX dual 100 BASE-FX ST Media Interface Card 
or a D20MX dual 100 BASE-FX LC Media Interface Card.

For a description of the operational status LEDs and port status LEDs, see “Front panel 
LEDs ” on page 87.

Figure 6: D20MX front panel with Ethernet connectors 

Ethernet 
Port 1

Ethernet 
Port 2

RS232 
Serial Port

Operational 
Status LEDs

USB Port (not 
supported)

Port 1 
Status LEDs

Port 2 
Status LEDs
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Figure 7: D20MX front panel with front access fiber optic connectors 

The D20MX can be used with an ST connector Fiber Optic card or an LC connector Fiber 
Optic card.

Figure 8: D20MX front panel and fiber optic card with rear access fiber optic 
connectors 

Fiber 
Optic 
Port 1

Fiber 
Optic 
Port 2

RS232 
Serial Port

Operational 
Status LEDs

USB Port
(not 

supported)

Port 
Status 
LEDs

Fiber 
Optic 
Port 2

Fiber 
Optic 
Port 1

RS232 
Serial Port

Operational 
Status LEDs

USB Port
(not 

supported)

Fiber Optic 
Port Status 

LEDs

LC Media Interface 
Fiber Optic card

D20MX front panel

Fiber 
Optic 
Port 2

Fiber 
Optic 
Port 1

ST Media Interface 
Fiber Optic card 

D20 chassis back view – 
Either an ST or LC connector Media Interface Card



CHAPTER 2: CONNECTING TO DEVICES AND NETWORKS

D20MX INSTRUCTION MANUAL GE INFORMATION 33

General cabling requirements
Table 13 lists the cables required to connect to the D20MX:

Table 13: Connection cables

To provide higher EMC immunity and maintain CE Mark radiated emission compliance, the 
serial cables used for permanent serial and D.20 Link connections must comply with the 
following requirements:

• Cables must be shielded

• D-type connector covers must provide EMC shielding (e.g. metallized plastic or die cast 
metal covers).

Serial

Seven serial communications ports are brought out to the backplane connector P2. These 
serial ports are five-signal (TXD, RXD, RTS#, CTS#, DCD#) DTE serial ports, compliant to 
ANSI/TIA-232 and TIA/EIA-694 specifications and are hosted by UARTs.
The D20MX is tested with all 7 serial ports running at 19200 baud with 20% CPU utilization. 
Refer to application configuration guides for supported baud rates and for data bits.

To avoid burning out the WESTERM or D20MX mainboard when directly connecting a rear-
panel serial port on one D20MX chassis to another rear-panel serial port on any type of 
D20 chassis, jumper the WESTERM of both chassis' to not provide a power connection to 
pin 4. Refer to the appropriate WESTERM module layout for jumper settings.

D.20 Link

Communications between the D20 and the D20 peripheral I/O modules are carried over a 
high-speed, high-level data link control (HDLC) protocol called the D.20 Link. The D.20 Link 
has the following features:

• RS-485 serial link, half duplex, 250 kbps

• D.20 frame using HDLC protocol format with Manchester encoding

• Supports up to 38 D20 I/O peripheral modules in a standard configuration

Media Designation Cabling Connector

Serial RS-232 Shielded DB-9 female

D.20 Link RS-485 
2 wire

Shielded DB-9 female

Twisted Pair Ethernet
(GE part number 526-3001 only)

10/100/1000BASE-T UTP (Unshielded Twisted 
Pair) – CAT 5 or better

RJ-45

Fiber optic
(GE part number 526-3003 and 
526-3005LF only)

100BASE-FX 1300 nm, 50/125 μm and 
62.5/125 μm multimode 
duplex fiber cable

ST-style 
connectors
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Peripherals
Peripheral I/O modules are intelligent modules containing an on-board microprocessor. 
They are configured as slaves to the D20MX processor board. In this way, specific I/O 
processing is distributed throughout the RTU to the appropriate I/O module.
There are five types of I/O peripherals:

• D20A analog input

• D20S digital inputs

• D20K digital output

• D20C combination input/output

• D20AC alternating current analog input

Optional high-voltage peripherals are also available.
The D20MX is only compatible with certain peripheral common code (i.e., pcommon) 
versions as defined in Table 14.

Table 14: Peripherals compatible with the D20MX 

Repeaters
Repeater and extension modules can be used to extend the distance between peripheral 
modules.

• D.20 Communication Interface: 520-0117.

• D.20 Fiber Optic Splitter 4-way: 520-0118.

• D.20 GFO: 520-0148.

I/O peripheral PCOMMON version compatibility PERFPAL version compatibility

D20C P022 - PCOMMON:
• 2 3.06, 3.05, 3.00 are compatible
• 2.21 and earlier are NOT compatible

PERFPAL 3 1.2 with OLD Base 
setting is compatible
PERFC 00 with NEW Base setting 
is compatible

D20A, D20S and 
D20K

P010 - PCOMMON:
• 3.06, 3.05, 3.01, 3.00 are compatible
• 2.21 and earlier are NOT compatible

PERFPAL 1 1.5 with OLD Base 
setting is compatible
PERFASK 00 with NEW Base 
setting is compatible

D20AC P087 - pBOOT 1.04, 1.03, 1.02 are compatible -
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Twisted-pair Ethernet (for 526-3001 only)

The10/100/1000BASE-T variant of the D20MX can connect to one or two networks through 
two twisted-pair Ethernet connections. In redundant LAN mode this causes the two 
Ethernet connections to use the same MAC address. Port 1 is the primary port and Port 2 is 
the secondary port. When the system detects a signal on Port 1, Ethernet traffic takes 
place on Port 1. When the system detects loss of signal on Port 1, Ethernet traffic takes 
place on port 2.
All RJ-45 connectors have the same signal definition. However, the twisted-pair Ethernet 
ports are auto MDI/MDIX and can support a straight-through or crossover cable.

NOTE

External switches must have Spanning Tree Protocol port settings configured to edge for 
proper operation.

To connect the D20MX 
to network devices

Plug network cables into the D20MX twisted-pair Ethernet ports.

NOTE

If the D20MX is deployed in the presence of strong RF energy in the 110 MHz - 125 MHz 
band, such as airport ILS localizers or aviation radio transmitters, it is recommended that 
shielded twisted-pair Ethernet cables be used.

Table 15: Ethernet RJ-45 connector signal definitions

Table 16: Ethernet crossover cable (RJ-45) pin out

Position Function Signal Flow Color

1 RX+ IN White w/ Orange

2 RX- IN Orange

3 TX+ OUT White w/ Green

4 P1+ - Blue

5 P1- - White w/ Blue

6 TX- OUT Green

7 P2+ - White w/ Brown

8 P2- - Brown

Shield - -

D20MX Switch/Hub

Name Pin Pin Name

TX_D1+ 1 3 RX_D2+

TX_D1- 2 6 RX_D2-

RX_D2+ 3 1 TX_D1+

RX_D2- 4 2 TX_D1-

BI_D3+ 5 7 BI_D4+

BI_D3- 6 8 BI_D4-

BI_D4+ 7 4 BI_D3+

BI_D4- 8 5 BI_D3-
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Table 17: Ethernet straight-through cable (RJ-45) pin 0ut

Fiber optic Ethernet (for 526-3003 and 526-3005LF 
only) 

The 100BASE-FX variant of the D20MX (GE part numbers 526-3003 and 526-3005) can 
connect to one or two networks through two fiber-optic Ethernet connections. 
The data rate on each port is 100 Mbps.

NOTE

You must enable Far End Fault Indication (FEFI) or Loss Link Alert (LLA) in connected 
external devices for proper redundant operation.

NOTE

External switches must have Spanning Tree Protocol port settings configured to edge for 
proper operation of 100Base-FX connected ports.

You can use the following glass optical fiber (GOF) cabling with the D20MX:

• 50/125 μm core/cladding multi-mode (gradient index) cable

• 62.5/125 μm core cladding multi-mode (gradient index) cable

• 100/140 μm core/cladding multi-mode (gradient index) cable

• 200 m core Hard-Clad Silica (HCS) multi-mode (step index) cable

You can use the following fiber optic terminations for D20MX cabling:

• ST Connectors (with 526-3003 and 526-3005LF + 526-3104LF fiber card)

• LC connectors (with 526-3005LF + 526-3103LF fiber card)

When calculating cable length, consider the following optical power levels:

• Glass optical fiber transmitter power is –19.0 ± 2 dBm

• Glass optical fiber receiver sensitivity is typically –25.4 dBm

This product contains components rated as Class 1 Laser Products.

D20MX PC

Name Pin Pin Name

TX_D1+ 1 1 RX_D2+

TX_D1- 2 2 RX_D2-

RX_D2+ 3 3 TX_D1+

RX_D2- 4 4 TX_D1-

BI_D3+ 5 5 BI_D4+

BI_D3- 6 6 BI_D4-

BI_D4+ 7 7 BI_D3+

BI_D4- 8 8 BI_D3-
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LAN redundancy

Both twisted-pair and fiber optic Ethernet options provide two LAN redundancy schemes 
called redundant LAN and dual LAN.
The redundant LAN scheme provides automated fail over between two Ethernet network 
connections (TX1/RX1 and TX2/RX2) that share a single MAC address.
When the primary port (that is, port 1) receives no signal, or detects a fault signal from the 
remote link partner, the D20MX switches to the secondary port (that is, port 2) if it has a 
valid link. The D20MX reverts to the primary port if the primary link is restored or no signal 
is present on the secondary port. 
With the dual LAN scheme, each port has a unique MAC, IP address and subnet. Each 
remote device participating in a dual LAN scheme must have a primary IP address 
reachable through the LAN A subnet of the D20MX and a secondary IP address reachable 
through the LAN B subnet of the D20MX. D20MX client applications fail over to the remote 
device's secondary IP address when they detect a failure to communicate with the remote 
device's primary IP address. D20MX server applications accept communications from the 
remote device's primary or secondary IP address. 
The LAN B subnet is normally assigned to Port 2 of the D20MX. However, it can be assigned 
to Port 1 as an “Alias IP”. This allows the D20MX to communicate with devices using the 
redundant LAN scheme and devices using the dual LAN scheme simultaneously.
To configure a system for redundant LAN operation, enable only LAN A in the device 
properties of the D20MX. To configure a system for redundant LAN operation with an Alias 
IP, enable both LAN A and LAN B in the device properties of the D20MX and set the “LAN B” 
field in the B152-1N IP Redundancy Monitor table to “Port 1”.
To configure a system for dual LAN operation, enable both LAN A and LAN B in the device 
properties of the D20MX and set the “LAN B” field in B152-1N IP Redundancy Monitor to 
“Port 2”. The D20MX device properties and the B152-1N IP Redundancy Monitor 
configuration may be configured through SGConfig 7.2 and higher.

IP addresses

The D20MX assigns IP configuration to its LAN A and optionally LAN B interface according 
to the rules defined in Table 18. 
In a standalone system, the D20MX assigns the LAN A and LAN B IP addresses exactly as 
you configured them in SGConfig. 
In a redundant system, the D20MX assigns the LAN A and LAN B IP addresses of the Active 
CCU exactly as you configured them in SGConfig. 
However, in other modes, the CCU assigns derived IP addresses as indicated in Table 18. 
For a description of the modes, refer to Table 20. The D20MX assigns the subnet mask of 
the derived IP addresses as the subnet mask configured in the LAN A or LAN B 
configuration.

Table 18: D20MX IP address assignment

CCU Redundant 
System

Mode LAN A IP Configuration LAN B IP Configuration (If 
Configured)

CCU A Standalone Active, Debug 
or Disabled

IP Address: LAN A IP 
Address
Mask: LAN B Subnet Mask 
(e.g 192.168.1.1 / 
255.255.255.0)

IP Address: LAN B IP 
Address 
Mask: Configured LAN B 
Subnet Mask (e.g. 
192.168.2.1 / 255.255.255.0)

CCU A Redundant Active

CCU B Redundant Active
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You may override or disable the derived IP address by defining a host with the desired IP 
address. Use an IP address of 0.0.0.0 to disable the derived IP address. Define the host in 
the SGConfig tool > D20 Device Wizard > Define the LAN properties for this project screen 
(see Figure 9 for an example). 

Figure 9: SGConfig - example of overriding derived IP address by defining a hostname 

Each host consists of a host name and host address. Construct the host name by replacing 
the last two characters of the D20 Host Name with a two character suffix that matches the 
derived IP address you wish to override or disable. The suffix conventions are shown in 
Table 19. The D20 Host Name appears in the D20 Device Wizard as shown in Figure 10.

CCU A Redundant Standby, 
Debug or 
Disabled.

Derived IP Address: LAN A 
IP Address + 1 
Mask: LAN A subnet mask 
(e.g. 192.168.1.2 / 
255.255.255.0)

Derived IP Address: LAN B 
IP Address + 1 
Mask: LAN B subnet mask 
(e.g. 192.168.2.2 / 
255.255.255.0) 

CCU B Redundant Standby, 
Debug or 
Disabled.

Derived IP Address: LAN A 
IP Address + 2 
Mask: LAN A subnet mask 
(e.g. 192.168.1.3 / 
255.255.255.0)

Derived IP Address: LAN B 
IP Address + 2 
Mask: LAN B subnet mask 
(e.g. 192.168.2.3 / 
255.255.255.0)

CCU A/B Redundant or 
Standalone

Service Mode Not enabled Not enabled

CCU Redundant 
System

Mode LAN A IP Configuration LAN B IP Configuration (If 
Configured)
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Figure 10: SGConfig - Host name shown in the LAN Settings 

Table 19: Host name suffix conventions

The D20MX can be in one of five modes as defined in Table 20. You can find the current 
mode of the D20MX by navigating to the SHELL in WESMAINT II+ and typing the command 
el.

Table 20: System mode definitions

HostName Suffix IP Address Corresponds To... Example

AA CCU A, LAN A FAC_DEFAA

AB CCU A, LAN B FAC_DEFAB

BA CCU B, LAN A FAC_DEFBA

BB CCU B, LAN B FAC_DEFBB

Mode Description Partial “el” output

Active D20MX applications are operational. Active CCU       YES

Standby D20MX applications are not operational but are 
ready to take over on a switchover command or 
a failover.

Standby CCU      YES

Disabled D20MX applications have been suspended due 
to an error. You must type el /r and boot in the 
SHELL to clear this error.

Disabled         YES

Debug D20MX boot sequence has been interrupted by 
pressing CTRL-E. Put the CCU into this mode in 
order to recover a system that has a corrupted 
configuration or code image. 

Redundant CCU    NO 
Standby CCU      NO 
Active CCU       NO 
Service Mode     NO 
Sys Service Mode NO 
Disabled         NO

Service Mode D20MX configuration has been corrupted or is in 
the process of receiving a new configuration. To 
recover the system, you must download a 
configuration serially.

Service Mode     YES
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RS-232

The RS-232 port on the D20MX is used to access the WESMAINT II+ facility and to transfer 
code and configuration data to the D20MX. You can use a VT100-compatible terminal or 
terminal emulation program to directly access the WESMAINT II+ facility. SGConfig's 
Terminal Emulator is an example of a suitable terminal emulation program.
The RS-232 port is connected to the D20MX front panel and is also routed to the rear panel 
as (COM0). The default baud rate is 19,200.

Non-responsive 
RS-232 port

In the event that the D20MX RS-232 port appears non-responsive, type Ctrl-Q. This non-
responsive condition might occur if your computer goes into sleep mode and then wakes 
up while still connected to the D20MX RS-232 port.

Use only a NULL modem cable (GE Energy part number 977-0529) when you are 
connecting to the D20MX front-panel RS-232 connector. Use of a WESMAINT cable does 
not allow communication to the D20MX.

Use only a standard WESMAINT cable (GE Energy part number 977-0300) when connecting 
to the rear panel COM0 connector. Use of a NULL modem cable causes permanent 
damage to the D20MX and PC.

D20 system redundancy

A redundant D20 setup allows a secondary D20 to automatically take over operations 
from a paired D20 unit that has failed.
D20 equipment redundancy requires:

• Two D20 units and 

• One or two RS-232 switch panels. 

NOTE

The quiescent current of the +12 V power supply input on the RS-232 Switch Panel is 15 
mA. The maximum power requirement on the +12 V input during operation is 230 mA.

Through a toggle switch on the RS-232 Switch Panel, you designate one of the CCUs as the 
Active unit. If the Active unit hardware or software fails, the Active CCU is automatically 
switched offline, and the Standby unit is switched through to the field equipment (i.e., it is 
made Active).
The RS-232 Switch Panel is not equipped with EMI protection circuitry. If the connection 
length exceeds 3m, a Serial Surge Protection Panel (GE item number 540-0249) or 
equivalent protection device should be installed.
Figure 11 shows a redundant D20 system, with CCU A active.
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Figure 11: Redundant D20 system with CCU A active

If the Active CCU fails:

• The Standby CCU detects the failure through the inter-CCU communications link.

• The Standby CCU commands the RS-232 Switch Panel to switch over all serial 
connections.

• The RS-232 Switch Panel switches all serial field connections to the Standby CCU, 
which now becomes the Active CCU.

If CCU A fails, CCU B becomes active. See Figure 12, “Redundant D20 system - If CCU A 
fails”.

Figure 12: Redundant D20 system - If CCU A fails
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Communications

RS-232 Switch 
Monitor and Control
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Figure 13: RS-232 Switch panel

A pair of LEDs marked CCU A and CCU B indicate which of the D20 units is currently active. 
If the hardware or software of the active unit fails, it is automatically switched offline and 
serial connections to the field are transferred to the standby unit. A toggle switch on the 
RS-232 switch panel can be used to switch the D20 devices between active and standby 
modes. 

Failover sequence
If the active D20 unit fails, the following actions occur:

1. The standby D20 unit detects the failure through the lack of a heartbeat signal on the 
ping cable or through a status change on the watchdog cable.

2. The standby D20 unit attempts to pull the RS-232 switch panel to assume the active 
state.

3. The RS-232 switch panel transfers all serial field connections to the standby D20, 
which then becomes the active D20.

Required components
To implement a redundant D20 system, you need the components: listed in Table 21.

Table 21: Redundant D20 system - required components

NOTE

Pins 4 on switch panel connectors J2 through J9 are tied together and to the panel’s power 
supply. Any loading from field devices on these pins, loads the RS-232 panel power supply 
and should be taken into consideration when sizing power supplies.

Active/Standby Sw itch

Power Indicator LEDs

CCU Indicator LEDs

CCU A

CCU B

PWR A

PWR B

Component Function Part Number

RS-232 Switch Panel Communications switch. 517-0247

Power Supply Power supply to power the RS-232 switch panel.
Input: 85 – 264 V AC or 90 – 350 V DC.

580-0046

Watchdog Cable 
Assembly

Connects D20 A to the RS-232 switch panel. 977-0160

Connects D20 B to the RS-232 switch panel. 977-0160

Ping Cable Assembly Links both D20 units to facilitate a heartbeat message 
that determines the status of the active unit .

977-0122

RS-232 Serial Cable Connects the D20 to the RS-232 switch panel which is 
then connected to external field devices.

977-0121

Power/SysFail Cable Connects the RS-232 switch panel to D20 external power 
supply.

970-0161

Ground Cable Provides a ground connection for the RS-232 switch panel. 970-0182



CHAPTER 2: CONNECTING TO DEVICES AND NETWORKS

D20MX INSTRUCTION MANUAL GE INFORMATION 43

To set up a redundant 
system

It is recommended that you install and configure one standalone D20 unit to ensure that 
your configuration is valid and that device communications are operating properly. Once 
this is done, proceed with the installation of the redundant system.

1. Mount the D20 units in a rack and connect power and ground.

2. Mount the RS-232 switch panel.

3. Plug the connector of watchdog cable A (GE part number 977-0160) to serial 
connector COM 6 on the first D20 (CCU A).

4. Connect the bare leads of watchdog cable A to TB1 (position 6-8) on the RS-232 switch 
panel.

5. Plug the connector of watchdog cable B (GE part number 977-0160) to serial 
connector COM 6 on the second D20 (CCU B). 

6. Connect the bare leads of watchdog cable B to TB1 (position 14-16) on the RS-232 
switch panel.

7. Connect the bare leads of both watchdog cables to TB1 on the RS-232 switch panel 
and the DB9 serial connector to either P1 or P9.

8. Connect one end of the ping cable to the first D20 and the other end to the second 
D20. This ping cable must be connected to the same serial port number on both units.

9. Use standard RS-232 cables (GE part number 977-0121) to connect the D20 serial 
communication ports to the serial ports on the RS-232 switch panel. P1 through P8 are 
connected to the first D20, P9 through P16 are connected to the second D20. 
Connections from the switch panel to both D20 units should be made in the same 
order. For example, if P1 is connected to port 3 on the first D20, P9 should also be 
connected to port 3 on the second D20.

10. Connect field devices to J1 through J8 on the RS-232 switch panel.

RS-232 switch panel operation
The RS2-32 switch panel has two sets of indicator LEDS:

• PWR A/PWR B: When lit , power and communications are received from the connected 
units. Normally, both LEDs are lit .

• CCU A/CCU B: Normally, one LED is lit , indicating which unit is active.

The active/standby switch on the front of the RS-232 switch panel is used to:

• Restore a previously failed unit to active status once it has been repaired.

• Manually force a unit to active status so that routine maintenance can be performed 
on the other unit.

To manually operate 
the RS-232 switch 

panel

1. Pull the active/standby switch straight out to release it from the locked position.

2. Switch it up to make unit A active or down to make unit B active.
The CCU A/CCU B LED indicator indicates which unit has been activated.

Redundancy wiring diagrams
Figure 14 illustrates how to wire the D20MX units and RS-232 switch panels to enable 
system redundancy:

NOTE

The D20MX watchdog (control) port, heartbeat (ping) port, and serial port assignments are 
software configurable. Refer to the D2x Configuration Guides.
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Figure 14: Redundancy wiring - single RS-232 switch panel
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D20MX Processor

Chapter 3: Installing the D20MX

Installing the D20MX

This chapter covers the following topics:

• D20 chassis layouts

• Overview of the steps and tools required to install the D20MX

• Retrofitting the D20MX in an existing D20

• Grounding the D20MX and connecting the power supply

D20 chassis layouts

Installation of the D20MX can be performed with one of three D20 chassis layouts; see 
“Installation steps” on page 47.
The D20 non-VME chassis front panel layouts for the D20MX upgrade kits comprise:

• A D20 containing a D20MX with front Ethernet connectors; see Figure 15.

• A D20 containing a D20MX with front Fiber Optic connectors; see Figure 16.

• A D20 containing a D20MX with rear Fiber Optic connectors; see Figure 17.
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Figure 15: D20 chassis front panel - D20MX with Ethernet connectors 

Figure 16: D20 chassis front panel - D20MX with front fiber optic connectors 
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Figure 17: D20 chassis front panel - D20MX with rear fiber optic connectors 

Installation steps

The D20MX can be installed in a non-VME (GE part number 500-0305) or VME (GE part 
number 500-0280) D20 chassis. If you are retrofitting an existing D20 device, See section: 
“Retrofitting the D20MX in an existing D20” on page 49. 
To install the D20MX in a D20 chassis

1. Ensure that you are sufficiently grounded to prevent ESD damage to the D20MX or 
other components. See section: “Grounding the D20MX” on page 52.

2. Remove the D20MX from its static-protective packaging. Set the packaging aside and 
save it for future reuse. See section: “Unpacking the D20MX” on page 52.

NOTE

The D20MX must be placed on an anti-static surface while not installed in the chassis.

3. Remove all horizontal blank faceplates.

4. Gently install the D20MX in the first (bottom-most) slot. Align the edge of the D20MX 
with the guide rails in the D20 chassis. 

NOTE

The D20MX is a double-height board that occupies two slots in the chassis. 
Handle the D20MX with care, since SMT components are located on the bottom side.

5. Push the front panel of the D20MX until it is seated properly and firmly connected to 
the backplane of the chassis.

6. Tighten the front panel retaining screws to 3.5 in-lbs to secure the D20MX to the 
chassis.

7. For the 526-3005LF version:

7.1. Remove the position 1 and position 2 vertical blank plates from the D20 
chassis.

7.2. Remove the D20MX Fiber Card from the static-protective packaging.

D20 chassis

D20 power supply

D20MX processor

D20MX cover 
plate

D20MX cover plate filler

D20MX Fiber Optic card
Protective earth 

terminal
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7.3. Connect the 20-pin header end of the cable (part number 975-1236) to 
connector P1 on the fiber optic daughter card.

7.4. Secure the cable to the fiber optic daughter card with a cable tie.

7.5. Insert the fiber optic daughter card partially into the chassis, and feed the other 
ends of the cable through the middle slot in the chassis wall between the VME 
slots and the peripheral slots.

7.6. Connect the other end of the cable (with two connectors) to the D20MX 
connectors J3 (shorter length of cable) and J4 (longer length of cable).
See Figure 20, “Cable to fiber optic daughter card,” on page 50. 
Ensure that the cable is not pinched. 

7.7. Push the front panel of the fiber optic daughter card until it is fully inserted.

7.8. Tighten the front panel retaining screws to 3.5 in-lbs to secure the fiber optic 
daughter card to the chassis.

8. Install the new lower filler plate (part number 953-1015).

9. Install the new filler plate (part number 953-1014) in the space above the D20MX.

10. Attach any required communication cables to the connectors on the front panel of the 
D20MX or the backplane of the D20 chassis.

11. If the D20MX is being installed in a VME chassis, connect the 0 V cable (part number 
975-1237):

11.1. Connect the bare end of the cable wire to the O V connector on the WESTERM 
terminal block TB2-9. 

11.2. Remove the wire from the lower 0 V connector on the VME backplane and 
connect this wire to the male end of the 0 V cable.

11.3. Connect the female end of the 0 V cable to the lower 0 V connector on the VME 
backplane.

See Figure 21, “0 V cable connection”.

12. Install the ferrite clamp.
If you ordered a complete D20 system including the D20MX with power cable, notice 
that a ferrite clamp has already been attached to the power cable. Go to step 13.
If you ordered a D20MX upgrade kit or a D20 system without power cable, a ferrite 
clamp included in the package is to be attached to the power inlet cable:

12.1. Ensure that you are sufficiently grounded to prevent ESD damage to the 
D20MX or other components. See “Grounding the D20MX” on page 52..

12.2. Remove ferrite clamp (GE part number 460-0073) from the package; handle 
with care as the magnetic material is fragile.

12.3. Pass the power cable through the channel, approximately 15 cm (6 inches) 
from the connector on the chassis.

12.4. Loop the power cable one more time around and through the core. See 
Figure 18.

Figure 18: Open ferrite clamp 
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12.5. Close the core and snap the halves together. See Figure 19.

Figure 19: Closed ferrite clamp 

12.6. Visually inspect the installation and confirm that the assembly has completely 
latched and that the power cable is not pinched. Also check that none of the 
power cable connections have come loose during the installation process.

13. Connect the power supply to the D20 chassis. See section: “Connecting the power 
supply” on page 52. 

14. Power-up the D20. See Chapter 4, Powering-up and Testing.

15. Start using the D20MX’s tools and utilities to configure and monitor the operation of 
the D20MX. See Chapter 6, Using the D20MX.

16. Make device and network connections. See Chapter 2, Connecting to Devices and 
Networks.

Retrofitting the D20MX in an existing D20

The D20MX processor board can be installed in an existing D20 device to replace D20ME 
D20M++, or D20MEII processor boards. If a D20 is being retrofitted, the following limitations 
exist:

• You cannot install multiple D20MX processor boards in a single D20. Therefore, a 
maximum of seven serial and two D.20 Link connections are supported on each D20 
unit.

• The D20MX supports 100BASE-FX instead of 10BASE-FL. If you are using any other 
devices in your system, and you are limited to 10BASE-FL, you must purchase a 
100BASE-FX to 10BASE-FL media converter.

The D20MX can be installed in a VME chassis or a non-VME chassis.
See section: “D20MX upgrade kits” on page 26 for a list of available upgrade kits and the 
parts provided within each kit. 

To retrofit the VME 
chassis and the non-

VME chassis

1. Ensure that you are sufficiently grounded to prevent ESD damage to the D20MX or 
other components. See section: “Grounding the D20MX” on page 52. 

2. Switch the power off for the D20 chassis.

3. Remove the D20ME, D20M++, or D20ME II module.

4. Remove the D20EME module and D20EME Media Interface Card.

5. Remove the horizontal blank faceplates, including the bottom faceplate.

6. If the chassis contains a modem card, move the modem card to position 2.

7. Follow the D20MX “Installation steps” on page 47.
See Figure 20, “Cable to fiber optic daughter card”.
Ensure that the cable is not pinched.
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Figure 20: Cable to fiber optic daughter card 

8. If the D20MX is being installed in a VME chassis, connect the 0 V cable (part number 
975-1237):

8.1. Connect the bare end of the 0 V cable wire to the O V connector on the 
WESTERM terminal block TB2-9. 

8.2. Remove the wire from the lower 0 V connector on the VME backplane and 
connect this wire to the male end of the 0 V cable.

8.3. Connect the female end of the 0 V cable to the lower 0 V connector on the VME 
backplane.

See Figure 21, “0 V cable connection”.

P1 connector on Fiber 
optic daughter card

J3 and J4 connectors 
on D20MX PCB

Cable

D20 Chassis - view 
through top panel
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Figure 21: 0 V cable connection 

Required tools and materials

Before beginning the installation procedures, have the following tools and equipment 
available:

• Appropriate device cables for D.20 connections (GE part number 977-0089)

• For D20MX Non-VME with Dual 10/100/1000Base-TX (part number 526-3001): CAT5 
network cables for RJ-45 Ethernet connections (GE part number 977-0280 or 
equivalent)

• For D20MX Non-VME with Dual 100Base-FX (part number 526-3003) and D20MX Non-
VME with Dual 100Base-FX Fiber Optic Card (part number 526-3005): multi-mode 
duplex fiber cable - ST connectors.

• Flathead screwdriver with 0.6 mm by 3.5 mm blade (for terminal block wiring)

• #1 Phillips screwdriver (for panel or DIN rail mounting the unit)

• #2 Phillips screwdriver (for rack mounting the unit)

• Needle-nose pliers

• Wire cutters

• Wire strippers

• Approved network settings for the device

• Windows-based PC with any Windows-based terminal emulation software and Web 
browser software installed

• 12 AWG wire (minimum) for protective earth

• 2 ring connectors, Panduit part number PV10-14R for 12 AWG [3.3 mm²] wire for 
protective earth terminal

WESTERM D20M+ SS 
Termination Panel

D20 VME Chassis

WESTERM D20VME - 
VME Bus Backplane

0 V 
Cable
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Grounding the D20MX

Surge and noise suppression components used on the D20MX are designed to prevent 
nuisance operation and damage to internal components. To ensure correct protective 
operation, the earth ground wire (14AWG green wire) on the D20 chassis must be 
connected to a low impedance ground rail of a secondary cabinet or rack.
When making ground connections, ensure that all surfaces that are used for grounding 
are free of dirt, residue and corrosion.

Do not power up the D20 before establishing a proper protective earth connection.

Unpacking the D20MX 

Carefully remove the D20MX from its packaging. Visually inspect the unit to ensure it has 
not sustained any visible damage during transit. If there are visible signs of damage, report 
it immediately to the carrier.

Package contents
The following items are provided as part of your D20MX shipment: 

• D20MX unit (GE part number 526-3001, or 526-3003, or 526-3005)

• For 526-3005LF only:

– D20MX to Fiber Card Harness (975-1236)

– D20MX 100BASE-FX Rear LC FO Card (part number 526-3103LF) or D20MX 
100BASE-FX Rear ST FO Card (part number 526-3104LF)

• Lower filler plate (part number 953-1015)

• Blank plate for D20MX install (part number 953-1014)

• 0 V wire cable (part number 975-1237)

• For 526-3005LF installed in 500-0280 only:

– Termination Panel, D20MX extended mounting (952-2087)

• GE Digital Energy Product Documentation CD (GE part number 581-0002)

• GE Digital Energy D20MX Documentation CD (GE part number 588-0075 V132)

Verify that you have received all items. GE parts include a unique number, typically in the 
format XXX-XXXX, that can be used as a reference.

Connecting the power supply

The D20MX processor board is supplied power through the WESTERM D20M+ SS 
backplane. Power connections to the backplane are made on connector block TB1.
For the WESTERM D20M+ SS and WESTERM D20M+ (see Figure 22, “WESTERM D20M+SS: 
power supply connections”) the power supply connections:

• 1 and 2 are used for input power connections based on the D20 power supply

• 4 and 5 can be used as a switched auxiliary power supply source
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• 7 and 8 can be used externally for status wetting, contact wetting and/or 
miscellaneous power connections, if applicable.

Figure 22: WESTERM D20M+SS: power supply connections 

14 AWG 
(green)
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Powering-up and Testing

Once you have made all field wiring and communication connections and have completed 
the necessary hardware configuration, the next step is to power-up the D20MX and verify 
that it is functioning properly.
Use this chapter to prepare for and correctly perform the power-up and other tests. This 
chapter includes:

• What is needed to test: WESMAINT II+ facility, SHELL and SGConfig

• How to power-up the D20MX and conduct the BOOT Test: Power On Self-Test

• How to carry out a redundant system test

NOTE

Before any of the tests and procedures in this section can be performed, a valid 
configuration file must be loaded into the D20MX NVRAM. 
If you have replaced the main board of the D20MX, then you need to restore the 
configuration file so that diagnostic tests can be performed.
If this power-up and test procedure reveals that your D20MX is not functioning properly 
due to software malfunction, then you need to download code and configuration files.
See the SGConfig online help.

Required for testing

The system components that are required for configuring and testing the D20MX are:

• WESMAINT II+ facility

• SHELL

• SGConfig application

To prevent burning out the main processor board, make two important checks before 
switching on the D20MX:

• Check that the external power supply input level is correct for the Power Supply fitted 
to the chassis. See section: “Power supply” on page 23.

• If you have 125 V DC or 110V AC input, then jumpers Z22 and Z23 on the WESTERM 
D20M+: 517 - 0225 or 517 - 0224 must be jumpered 2 - 3.
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Accessing WESMAINT II+ using a terminal
You can use a VT100-compatible terminal or a terminal emulation program to directly 
access the WESMAINT II+ facility. SGConfig's Terminal Emulator is an example of a suitable 
terminal emulation program.

NOTE

For further information about using WESMAINT II+ software to perform any of the test 
procedures in this section, refer to the WESMAINT II+ User’s Guide.

Terminal Emulation
Microsoft Windows™ HyperTerminal can be used for terminal emulation but it is NOT 
recommended because code and configuration file download times are considerably 
increased. 

TIP

The program Tera Term for Microsoft Windows™ does not have these limitations and is 
therefore recommended as a terminal emulation program. It can be downloaded from the 
Internet. 

SHELL
The SHELL is a debugging and diagnostics tool that is accessible as a menu selection in 
WESMAINT II+, or from a basic login prompt if WESMAINT II+ is not available.

The approved method of using the diagnostic tools of the SHELL is through the front RS232 
port. 

Power up and test steps

To power up and test the D20MX:

1. “Set up a PC to act as a WESMAINTII+ terminal”. See page 57.

2. “Power up the D20MX” on page 57. See page 57.

Result: The D20MX automatically runs the Online Start-up test. See “Automatic on-line 
start-up test” on page 57.

3. “Test for redundancy”. See page 58.

4. “Check that fail-over is functioning correctly”. See page 59.

5. “Check that switch-over is functioning correctly”. See page 59.

6. “Verify either hardware or software switch-over”. See page 60.
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Set up a PC to act as a WESMAINTII+ terminal

To set up a PC to act 
as a WESMAINT II+ 

terminal.

1. Open the VT100 compatible terminal emulation software you are going to use.

2. Verify (or set) terminal communications settings as follows:

Result: The terminal emulator settings are now configured.

Power up the D20MX

To power up the 
D20MX

1. Check that all field wiring, grounding wires and fuses are in place and secure on your 
D20 system.

2. Turn the chassis-mounted Power Supply switch to ON.

Result: The unit is powered-up.

3. On start-up, inspect the D20MX LED indicators on the front panel. 

Result: The RDY LED is flashing. 

Automatic on-line start-up test

The D20MX automatically boots up when the power is switched on. Internal processes 
perform a series of routines. Self-diagnostic tests are performed followed by the spawning 
of all the software applications that reside in the unit's memory.
The self-diagnostic tests generate PASS or FAIL messages that can be viewed in your 
terminal emulator WESMAINT II+ screen. You can also see the results of the application 
spawning process.
Pass/Fail tests are carried out on the:

• User RAM

• NVRAM

• FLASH memory

• Root process

The self-diagnostics also return measures for:

• SDRAM size

• Bus Speeds

• CPU Core Speed

The NVRAM CRC test verifies that the configuration header is valid. If this fails, then the 
D20MX starts with a minimal set of applications that allow the system to be restored. 

Setting Value

Data Rate 19200 bps

Data Bits 8

Stop Bits 1

Parity None

Flow Control Xon/Xoff (software)

Connector Settings COM1 or COM2, as required by the computer you are using
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Code and configuration files
If the code and configuration files compiled for your specific system are already 
downloaded, then you can login straightaway to WESMAINT II+ for powering-up and 
testing.
If your system-specific code and configuration files are not downloaded, then you need to 
power-up with the default configuration. You can then login to the SHELL, download your 
system-specific files and restart the D20MX for testing.
For details, see the SGConfig online help. 

Further testing
For further specific testing, log in to WESMAINT II+. See the WESMAINT II+ Users Guide and 
WESMAINT user guides for specific applications.

Test for redundancy

If you have a D20 redundant system, you must test that:

• CCU A and CCU B are communicating

• Fail-over is functioning correctly.

To check that CCU A and CCU B are communicating once you have powered-up the 
Primary and Secondary units:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated.

2. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the active D20MX. 

3. Attach the other end of the cable to the serial communications port of the PC or 
terminal.

4. Login to WESMAINT II+ through the emulator you are using.

Result: The WESMAINT Main Menu is displayed.

5. Check to see that STNDBY appears at the top-left of this WESMAINT screen.

Results: If this text shows, then the Primary and Secondary CCU are communicating.

If this text does not show, then the Primary and Secondary are not communicating.

NOTE

STNDBY appears on the Active CCU WESMAINT Main Menu display approximately one 
minute after power-up of the two units. Wait for this message to appear before following 
the next procedure.
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Check that fail-over is functioning correctly

To check that fail-over is functioning correctly for the event of hardware failure:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated. 

2. To simulate hardware failure, switch off the Active D20MX at the main power switch 
on the front of the unit.

Result: If the RS-232 is functioning correctly, then it switches over to the Standby unit 
and the CCU B LED illuminates and the CCU A LED goes off.

Check that switch-over is functioning correctly

To check that switch-over is functioning correctly for the event of software failure:

1. On the front of the RS-232 Panel, check that CCU A LED is illuminated, which shows 
that CCU A is Active.

NOTE

Both the PWR A and PWR B LEDs should be illuminated.

2. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the D20MX designated as CCU A.

3. Attach the other end of the cable to the serial communications port of the PC or 
terminal.

4. Login to WESMAINT II+ on CCU A using your terminal emulator.

Result: The WESMAINT Main Menu appears.

5. Select Main Menu > System Functions and press ENTER.

Result: The WESMAINT Function Menu appears.

6. Select SWITCH-OVER on the Function Menu and press ENTER.

Result: A password prompt appears.

7. Enter your password and press ENTER. The default password is control.

Result: The CCU Switch-Over display appears.

8. Press Ctrl-V to begin switch-over.

Result: A confirmation message appears: Confirm Yes/No.

9. Type Yes and press ENTER.

Result: Fail over occurs
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Verify either hardware or software switch-over

To verify either hardware or software switch-over.

1. Connect a NULL modem cable (GE Energy part number 977-0529) to the RS-232 
connector on the front panel of the D20MX designated as CCU B, which was originally 
the Standby unit.

2. Attach the other end of the cable to the serial communications port of the PC or 
terminal. 

3. Login to WESMAINT II+ through the emulator you are using.

Result: The WESMAINT Main Menu is displayed.

4. If you can login to WESMAINT II+, this indicates that CCU B is the Active CCU.

Results: Fail over has occurred.

NOTE

If the previously Active A CCU powers-up after a fail-over from CCU A to CCU B, then 
STNDBY appears at top left when you login to WESMAINT II+ on CCU B. This can take 
up to a minute to occur.

NOTE

If you cannot login to WESMAINT II+ on a CCU, then the unit is most likely powered down. 
Verify that the RDY LED is flashing and verify that the serial cable is connected correctly.
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Configuring the Software

This chapter provides:

• An introduction to the software components used in the D20MX.

• An overview of the software tools you use.

• How to download image files to the Flash memory on your D20MX module on your 
system using a serial or network connection.

• A description of the SGConfigTM firmware options

• How to transfer D20/D200 configurations to the D20MX

• How to update D20/D200 configurations to use the D20MX firmware definition

Introduction to the D20MX software

The D20MX main processor board requires three valid files to be loaded:

• An operating system image file, called “vxWorks”, which resides in the file system on 
Flash memory

• An application image file, called “appl.out”, which resides in the file system on Flash 
memory

• A configuration file which resides in the NVRAM

Use this section to load the image files of your RTU system.

Image file terms The following terms are used throughout this chapter of the manual when referring to the 
image files:

• Collectively the files vxworks and appl.out are to be referred to as “image files”

• vxworks refers to the “operating system image file”

• appl.out refers to the “application image file”
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Customer service shell access

In certain cases, GE customer service may require access to a low-level shell called the “C” 
shell in the D20MX in order to troubleshoot a problem. The “C” shell is accessible from the 
D20M shell by typing c. To leave the shell, type exit .
The “C” shell can only be accessed from an RS232 port of the D20MX, and it must be 
enabled by a user whose “Monitor Access Level” is Read/Write (i.e., Administrator role). 
Once the “C” shell is enabled, only a user whose “Monitor Access Level” is Maintenance (i.e., 
Engineer role) or Read/Write is able to access the “C” shell.
“C” shell access is enabled by typing eds in the D20M shell. The eds command takes a 
parameter which defines how many seconds that a user is allowed to enter the “C” shell. 
Until the eds timer expires, a user with appropriate access is allowed to enter or re-enter 
the “C” shell as many times as required. After the eds timer expires, entry to the “C” shell is 
no longer allowed. If the parameter is not specified, the default timeout is 300 seconds 
(5 minutes).
A user log is generated each time a user runs the eds command or enters the “C” shell.

D20MX user accounts 

The D20MX supports the following types of user accounts:

• Remote and local user accounts

• Factory default user account

• System default user account

Remote and local user accounts
The D20MX supports remote and local user accounts. Use remote user accounts whenever 
possible to increase the level of security and to decrease user administration effort. To 
implement remote user accounts, the D20MX uses Remote Authentication Dial-In User 
Service (RADIUS) with CHAP, EAP-TTLS and PEAP authentication methods. Refer to the 
B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to 
configure the D20MX to use RADIUS.
When RADIUS is used, your RADIUS server provides a role ID to the D20MX. The role ID 
defines which commands and displays the user is allowed to access while logged in to the 
D20MX. To allow your RADIUS server to provide a role ID, configure your RADIUS server to 
use the GE vendor profile that is common to many Multilin products. Refer to the B014-
1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to configure 
your RADIUS server and the D20MX with the GE vendor profile. Also refer to Appendix A, 
Default Role-Based Access Control Model for the default role based access control model 
provided with the D20MX default configurations.
In the event all configured RADIUS servers are down or if RADIUS is not configured, the 
D20MX authenticates the user against the local configuration and password file. Local 
users are created with a default password of changeme. Use the passwd command from 
the D20MX SHELL prompt to change the default password to a strong password as soon 
as possible after downloading the configuration.   Refer to the B014-1NCG WESMAINT II+ 
for the D20MX Configuration Guide for details on how to configure local user accounts and 
change the password of a user. 
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Factory default user account 
The factory default configurations for the D20MX come with one default user account with:

•  username: admin

•  password: changeme

Replace this account or change the password for this account as soon as possible. Refer to 
the B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for details on how to 
modify user accounts and how to change the password of a user. 

System default user account
The D20MX configuration can be defaulted by pressing CTRL-F on a terminal connected 
over the front RS232 port during startup. In addition, if the D20MX detects a corrupt 
configuration on startup, it generates a system default configuration. The system default 
configuration comes with one user account:

• username: recover

• password: system

Login with this username and synchronize a configuration to the D20MX over the front 
RS232 port. 

NOTE

The D20MX can only be accessed over the front RS232 port with the system default 
configuration.

If you synchronize a configuration with any of the following errors:

• There are no usernames configured in the B014 User table,

• The B014 User table is disabled, or

• The B014 application definition does not match the firmware version, 

then the applications do not start and you only have serial access in debug mode.
Login with the system default username over the front RS232 port and synchronize a 
correct configuration.

Download image files to the D20MX

When to download
Instances where you may need to download an operating system or application image file 
to your D20MX:

• When a new version of the operating system or application image has been released.

• If the D20MX has performed self-diagnostics and determined that the application 
image file is either missing or corrupted.

• After maintenance or replacement work that has deleted the application file.

Prerequisites for image download
The following items must be available before an application or operating system image file 
can be loaded into a D20MX over a serial or network link:

• Windows PC with SGConfig version 7.2 and higher software.

• The application firmware file, preferably located on a local hard drive.

This file is to be named: appl.out.
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• The operating system image file, preferably located on a local hard drive.

This file is to be named: vxWorks.

• The D20MX module must be installed into a D20 chassis, ready to power-up.

Prerequisite for image 
download over a 

serial link

The following item must be available before an application and operating system image 
file can be loaded into a D20MX over a serial link:

• A NULL modem cable (GE Energy part number 977-0529) connecting the RS-232 
connector on the front panel of the D20MX to the serial communications port of a PC 
or terminal. 

Prerequisite for image 
download over a 

network link

The following items must be available before an application and operating system image 
file can be loaded into a D20MX over the network:

• An Ethernet switch and appropriate Ethernet patch cables to connect your PC's 
Network Adapter and the D20MX's Ethernet port 1 to the switch.

• The D20MX contains a configuration file with LAN enabled and an IP address that 
matches the one configured in SGConfig.

• The PC's Network Adapter is configured with an IP address on the same network as 
the IP address of the D20MX.

Download software over a serial connection
To download software to the D20MX:

1. Set up Tera Term on a PC. See section: “Set up Tera Term on a PC” on page 64.

2. Download application image file to the D20MX over a serial connection. See section: 
“Download image files to the D20MX over a serial link” on page 65.

This comprises:

– Application files

– Operating system files

Set up Tera Term on a 
PC

To set up the Tera Term on a PC:

1. Connect a NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector on the front panel of the D20MX to the serial communications port of the 
PC or terminal.

2. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

3. Open a project containing a D20MX device.

Result: The project's Main Page appears.

4. Click on a D20MX device.

Result: The ribbon changes to include the Communications group.

5. Click Configure ribbon group > Communications > Connect drop-down list > Tera 
Term.

Result: Tera Term: New connection dialog appears

6. Click Serial and select the communications port on your PC from the Port drop-down 
list. 

7. Click OK.

Result: Tera Term: New connection dialog closes

Result: The Tera Term VT window appears
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8. Select Setup > Serial port…

Result: Tera Term: Serial port setup dialog appears

9. Verify (or set) terminal communication settings as follows:

10. Click OK.

Result: The Tera Term settings are now configured.

Download image files 
to the D20MX over a 

serial link

To download application and operating system image files to a D20MX module:

1. Restart the D20MX.

Result: The startup messages appear.

2. When the message “Press Ctrl-E to enter debug mode…” appears, press Ctrl-E within 5 
seconds.

Result: The login dialog appears.

3. Log in:

– For User: type a username that has Maintenance or Read/Write Access and press 
Enter, 

– For Password: type the password and press Enter. 

Result: The D20M> prompt appears.

4. Optional: Speed-up communications to shorten download time.

Type Baud 115200 and press Enter.

Note: Select 57600 or 38400 if communications errors have occurred previously. Such 
errors can occur due to the presence of ambient EMI, a long cable length, a PC with 
communication limitations due to CPU speed or when using some serial to USB 
adapters. 

Result: The D20MX is now communicating at 115,200 baud.

4.1. Select Setup > Serial port…
Result: Tera Term: Serial port setup dialog appears.

4.2. Select 115,200 from the Baud Rate drop-down list. 

4.3. Click OK.
Result: Tera Term main window appears and is communicating at 115,200 
baud.

5. Download the application image file:

5.1. Press Enter to verify that communication is active. 
Result: The D20M> prompt appears if the connection is active.

5.2. Type rz and press Enter to put the D20MX into the state where it is ready to 
receive the downloadable code file

5.3. Click File > Transfer > ZMODEM > Send from menu bar
Result: A dialog box opens, prompting you to locate the appl.out file that you 
wish to download.

Setting Value

Port: COM1 or COM2, or as required by the computer you are using.

Baud Rate 19200 bps

Data 8 bit

Parity none

Stop 1 bit

Flow Control Xon/Xoff

Transmit delay 0 msec/char; 0 msec/line
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5.4. Select the correct file, and click Open to start the transfer

NOTE

Do not press any keys on keyboard and do not move the Tera Term window 
during download.
Result: The file transfer may take from less than 10 to over 30 minutes, 
depending on communication speed selected. 
When complete, the D20M> prompt appears.

6. Download the operating system image file

6.1. Press Enter to verify that communication is active. 
Result: The D20M> prompt returns if connection is active

6.2. Type rz and press Enter to put the D20MX into the state where it is ready to 
receive the downloadable code file.

6.3. Click File > Transfer > Send from menu bar.
Result: A dialog box appears, prompting you to locate the vxWorks file that you 
wish to download.

6.4. Select the correct file, and click Open to start the transfer

NOTE

Do not press any keys on keyboard and do not move the Tera Term window 
during download.
Result: The file transfer may take from less than 10 to over 30 minutes, 
depending on communication speed selected. 
When complete, the D20M> prompt appears.

7. Type cf to copy the image files to flash.

Result: The copy may take a few minutes to complete. When complete, the D20M> 
prompt appears.

8. Type el /r to ensure that log is clear.

9. Type boot to restart device.

Result: The image file load is completed.

The flash memory of the D20MX now has the new application and operating system 
image file loaded.

Configuration File 
Download

You can use standard SGConfig procedures to download a configuration file over the serial 
port.

Download image files over a network connection

Procedure To download application and operating system image files to the D20MX over a network 
connection:

NOTE

In the event that you have selected dialog checkbox “Do not show this message again”, 
some of the following steps do not appear. Accordingly, ignore the affected steps.

1. Connect Ethernet port 1 of the D20MX to the Ethernet switch using the appropriate 
Ethernet patch cable. 

2. Connect the PC's network adapter to the Ethernet switch using the appropriate 
Ethernet patch cable.

3. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

4. Open a project containing the target D20MX device.

Result: The project's Main Page appears. 



CHAPTER 5: CONFIGURING THE SOFTWARE

D20MX INSTRUCTION MANUAL GE INFORMATION 67

5. Click on the D20MX device.

Result: The Communications group appears in the ribbon.

6. Click Configure ribbon group > Communications > Options.

Result: D2x Device Communication Options dialog appears

7. Click Interface tab > Connection Type > iSCS LAN and select the Preferred LAN you 
wish to use, either LAN A or LAN B. This is most likely to be LAN A. 

8. Click OK.

Result: D2x Device Communication Options dialog closes.

9. Click Edit ribbon group > Properties.

Result: A Dialog appears, prompting you to make a backup copy. 

10. Click Yes or No depending on whether you want to make an internal backup copy. 

Result: If you click Yes, a dialog appears indicating that the device is being backed up. 
Finally, a dialog appears indicating that the device has been backed up. 

11. Click OK. 

Result: The D20 Device Wizard appears

12. Click Next .

Result: The Project LAN properties appear.

13. Click Next .

Result: The hardware and other properties appear for the device.

14. Click Processor tab > Code Image sub-tab. 

15. Click the button with the ellipsis (…).

Result: The Select Flash image file dialog appears.

16. Navigate to the folder containing the appl.out file and vxWorks file. 

17. Select the appl.out file and click Open.

Result: The full pathname of the appl.out file appears in the Flash Image File box.

Note: To transfer the operating system image, simply ensure that a vxWorks file exists 
in the same folder as the selected appl.out file. SGConfig automatically transfers both 
files to the D20MX even though you only selected the appl.out file. 

18. Click Next . 

19. Click Finish.

Result: The project's Main Page appears with the D20MX device selected.

20. Click the ribbon Configure group > Configuration > Generate.

21. Confirm that there are zero errors in the Device Log.

22. Click the ribbon Communications group > Firmware transfer.

Result: Warning message appears and confirmation to continue is requested.

23. Acknowledge the warning and click Yes to continue or No to abort the operation.

Result: If Yes is selected, then refer to the following table. If No is selected, the 
operation is aborted.

Possible Result if Yes is Selected When to expect this result Go to step

Select Target IP Address dialog 
appears

If the D20MX is configured for device 
redundancy.

24

Login dialog appears If the D20MX is not configured for device 
redundancy.

26
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24. Choose one of the following options:

– If the default standby IP address is not the correct one, click the Standby IP 
address checkbox and in the associated IP address field, enter the IP address of 
the standby unit.  
Tip:   Click Help for information on how to determine the Standby IP address.

– Click the Active IP address checkbox. 

25. Click OK.

Result: A login dialog appears.

26. Enter a User Name that has Maintenance or Read/Write access. Enter the associated 
Password.

Result: The firmware transfer takes place. A dialog indicating the transfer and reboot is 
taking place is presented. The unit is rebooted once the transfer finishes. Once the 
reboot completes, the dialog disappears. The whole operation can take up to 8 
minutes.

The flash memory of the D20MX now has the new application and operating system 
image file loaded.

27. If the D20MX was configured for device redundancy, you may switch over the D20MX 
and repeat the above steps for the other unit.

Configuration file 
download

You can use standard SGConfig procedures to download a configuration file over the 
network.

Firmware integrity
The D20MX firmware uses a Firmware Integrity checking mechanism. This mechanism 
consists of a Primary and Secondary storage system, internal to the D20MX, for the 
firmware files and an MD5 checksum on the individual firmware files.
Two D20M Shell commands: commit and revert copy the firmware files from the Primary 
storage to the Secondary (commit), or from the Secondary to the Primary (revert).
The D20MX determines which set of files (Primary or Secondary storage) to use when 
starting up by:

1. Testing the integrity of the D20MX firmware files in the Primary storage. 

2. If the integrity check of the Primary storage files is valid, the D20MX starts up with the 
Primary storage files.

3. If the integrity check of the Primary storage files fails, the D20MX tests the integrity of 
the firmware files in the Secondary.

4. If the integrity of the Secondary storage files is valid, the D20MX starts up with 
Secondary storage files.

5. If the integrity of the Secondary storage files fails, the D20MX defaults to the Boot 
ROM command prompt. 

Committing new firmware
After new firmware has been downloaded (either via serial or network connection), and the 
D20MX has restarted and is operating correctly, the firmware must be “committed” to the 
secondary storage.

Once the firmware has been committed, it cannot be reverted; see Section: Reverting old 
firmware.

To commit new firmware:

1. Login as a user that has Maintenance or Read/Write access privileges.
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2. Enter the D20M Shell.

3. Enter the commit command. 

Result: A prompt appears to confirm copying the firmware from Primary to Secondary.

4. Enter yes to confirm the copy operation. If anything else is entered, the command is 
canceled.

Result: The firmware copy operation begins. Both 'vxworks' and 'appl.out' are copied.

This operation takes approximately 3 minutes.

DO NOT shut off the power to the D20MX while the copy operation is in progress. If power 
to the D20MX is disrupted, during the copy operation, the firmware is likely to be corrupted.

Reverting old firmware
A previously committed version of the firmware may be recovered from secondary 
storage.
This features is intended to be used in one of two cases:
• Case 1: The primary version of the firmware has become corrupt. Reverting the 

firmware copies the firmware from the secondary storage into the primary storage.

• Case 2: If, after downloading a new version of the firmware, an issue is identified and 
you wish to recover the previous version of the firmware. A revert is only possible if the 
new firmware has not been committed; see Section: “Committing new firmware” on 
page 68.

To revert the firmware:

1. Login as a user that has Maintenance or Read/Write access privileges.

2. Enter the D20M Shell.

3. Enter the revert command 
Result: A prompt appears to confirm copying the firmware from Secondary to Primary.

4. Enter yes to confirm the copy operation. If anything else is entered, the command is 
canceled.
Result: The firmware copy operation begins. Both 'vxworks' and 'appl.out' are copied.

This operation takes approximately 3 minutes.

DO NOT shut off the power to the D20MX while the copy operation is in progress. If power 
to the D20MX is disrupted, during the copy operation, the firmware is likely to be corrupted.

5. Once the copy operation has completed, enter the boot command to restart the 
D20MX with the reverted firmware.

Migrate D20MX application definitions to SGConfig

Use this information to migrate the D20MX application definitions to SGConfig. This step 
only needs to be performed once on a configuration computer. 

Prerequisites Before you can migrate the D20MX application definitions to SGConfig, the following 
components must be present:

• SGConfig 7.2 or higher installed on the configuration computer.

• D20MX Documentation CD (part number 588-0075 V132) in either of the following 
formats:

– Physical CD media, or 

– Zip file
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Procedure To migrate the D20MX application definitions to SGConfig:

NOTE

Ignore any steps that refer to dialogs where you selected “Do not show this message 
again”.

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Click the GE button > Migration Wizard.

Result: The Welcome to the Migration Wizard screen appears.

3. Click Next .

Result: The Select Task screen appears.

4. Select Import application definitions and click Next .

Result: The Import application definitions screen appears.

5. Click the Retrieve from archive button.

Result: The Choose file dialog appears.

6. Navigate to the folder Configuration Files\ApplicationDefinitions on the D20MX 
Documentation CD or extracted zip file, and select the zip file there. Then, click OK.

Result: The Import application definition screen re-appears. The Available Applications 
list contains many applications.

7. Click Select All and then Next .

Result: The Importing Application Definitions progress dialog appears momentarily. 
The migration may take a few minutes. 

Result: The Task completed dialog appears. 

8. Click Next and Finish.

Transfer D20/D200 configurations to the D20MX 

Use this information to transfer existing D20 and D200 device configurations to the 
D20MX.

NOTE

The word “transfer” is used within the context of this guide to mean that the device 
configuration files are moved and modified, in order to work properly on a D20 with a 
D20MX processor.

If you are transferring a D20 device configuration, follow the steps in section: “Transferring 
a D20 configuration to the D20MX” on page 71.
If you are transferring a D200 device configuration, follow the steps in the following 
sections:

• Section: “Transferring a D200 configuration to the D20MX” on page 78

• Section: “Transferring a D20 configuration to the D20MX” on page 71
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Transferring a D20 configuration to the D20MX

Prerequisites Before you can transfer a D20 device configuration, the following components must be 
present:

• SGConfig installed on the configuration computer. The minimum SGConfig version 
supported is 7.2, but version 7.4 or higher is recommended.

• The D20MX application definitions have been migrated to the configuration computer 
using the instructions in Section: Migrate D20MX application definitions to SGConfig. 

• D20MX Documentation CD (part no. 588-0075 V132) in either of the following formats:

– Physical CD media, or 

– Zip file

• D20 Configuration has been migrated to SGConfig with the Migration Wizard (Refer to 
the Migration Wizard screencast). 

Note: The Migration Wizard supports ConfigPro 2.0 and higher configurations.

• To save time, you may upgrade the firmware definition of your D20 or D200 
Configuration to SAN0001 or SAN0002 in ConfigProTM 5.03 or higher. If you choose to 
take this option, follow the instructions provided in Section: “Updating D20/D200 
configurations to use the D20MX firmware definition with ConfigPro” on page 79, 
before migrating the D20 configuration to SGConfig.

• A NULL modem cable (GE part number 977-0529) connecting the RS-232 connector 
on the front panel of the D20MX to the serial communications port of the 
configuration computer.

Procedure To transfer a D20 or D200 device configuration to the D20MX:

NOTE

In the event that you have selected dialog checkbox “Do not show this message again”, 
some of the following steps do not appear. Accordingly, ignore the affected steps.

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Choose the D20MX Factory Default Configuration file, D20MX01-132.7zip or 
D20MX02-132.7zip. based on the following criteria:

– If transferring a configuration containing B009 versions greater than 310 and 
B021 versions greater than 912 use the file D20MX01-132.7zip

– If transferring a configuration containing B009 versions less than or equal to 310 
and B021 versions less than or equal to 912, use the file D20MX02-132.7zip. 

3. If the D20MX01-132 or D20MX02-132 default configuration has already been 
imported, go to step 4 to open the default configuration. Otherwise perform these 
steps:

3.1. Click GE button > Archive > Project > Restore.
Result: The Restore Project Details window appears.

3.2. Click … .
Result: The Choose a File window appears.

3.3. Navigate to the DVD/CD drive > Configuration Files > SGConfig. 
Result: The two files D20MX01-132.zip and D20MX02-132.zip appear in the 
dialog. 

3.4. Select the appropriate file based on your decision in step 2. 

3.5. Click OK. 
Result: On completion a pop-up message appears (e.g., Project D20MX01-132 
has been restored). 
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3.6. Click OK.

4. Open the D20MX Factory Default Configuration D20MX01-132 or D20MX02-132: click 
GE > Recent Projects > select D20MX01-132 or D20MX02-132.

5. Copy the firmware definition from the factory default configuration to the project 
containing the D20 configuration (if you had opted to upgrade the firmware in 
ConfigPro, then this step is not necessary): 

5.1. Click anywhere on the main page of the project to deselect the device.

5.2. Click the ribbon Configure group > Miscellaneous > Firmware Library.
Result: The Firmware Library window appears with the firmware definition 
selected.

5.3. Select SAN0001/132 or SAN0002/132 based on the decision taken in step 2.

5.4. Click Copy.
Result: The Firmware Information window appears.

5.5. Set the Project Name in the Copy To region to the project containing the D20 
configuration.

5.6. Click OK.
Result: The Firmware Information window closes.

5.7. Click Close.
Result: The Firmware Library window closes.

6. Export the RADIUS roles from the default configuration:

6.1. Double-click the D20 device named FAC_DEF.
Result: The Application List popup appears.

6.2. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

6.3. Right-click the RADIUS Role Table icon and select Export
Result: The Export Options dialog appears.

6.4. Use the default settings for System Point Fields and click on the button 
containing an ellipsis (...) under the Place export files in area.
Result: The Choose a folder dialog appears.

6.5. Browse to a folder (e.g. your Desktop) and click OK, OK, Cancel, and Close.
Result: The main page of the project appears.

7. Export the IP Redundancy Monitor point descriptors from the default configuration:

7.1. Double-click the D20 device named FAC_DEF
Result: The Application List popup appears.

7.2. Double-click the System Point Database application.
Result: The System Point Database Properties dialog appears.

7.3. Select IP Redundancy Monitor and click Descriptors.
Result: The Point Descriptors dialog appears.

7.4. Click on the Export button. 
Result: The Export Point Descriptors dialog appears.

7.5. Use the default settings for the Select Range of Points to Export and click OK.
Result: The Browse For Folder dialog appears.

7.6. Browse to a folder and click OK, OK, Cancel and Close.
Result: The main page of the project appears.

8. Close the D20MX Factory Default Configuration (i.e. D20MX01-132 or D20MX02-132):

8.1. Click GE > Close Project . 
Result: The Close Project window appears.
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8.2. Select: D20MX01-132 or D20MX02-132.

8.3. Click OK.

9. Open the SGConfig project containing the D20 device.:

9.1. Click the GE button.

9.2. Click the required SGConfig project in the Recent Projects list or select the 
Open Project menu item.

10. Generate a report of the applications in the original D20 device configuration and 
determine the unused applications.

10.1. Click the Project tab of the original D20 device configuration.

10.2. Click the D20 device.

10.3. Right click the D20 device > Miscellaneous > Reports.
Result: The Select Reports dialog appears.

10.4. Click Application List and OK
Result: An new tab named Reports opens and contains the Application List 
report for the original D20 device.

10.5. Compare the Application List report with Table 2 on page 17. 
With the exception of IP Redundancy Monitor (B152-1), note the applications 
that appear in Table 2 but not in the report. You may want to print Table 2 and 
mark these applications. These applications are referred to as “unused” 
applications in the steps to follow.

10.6. Click the x button on the Reports tab.
Result: The Project tab of the original D20 device configuration reappears.

11. Make a backup copy of the original D20 device configuration:

11.1. Click the Project tab of the original D20 device configuration. 

11.2. Click the D20 device.

11.3. Click the ribbon Configure group > Edit > Copy.

11.4. Click a blank area on the page onto which the copy is to be placed. 

11.5. Click the ribbon Configure group > Edit > Paste.
Result: The Copying device window appears. 
Result: Once completed a new device named COPY_OF_<original device 
name> or <original device name>_COPY appears. 

12. Select a D20MX processor from the D20 Device Wizard: 

12.1. Click the Project tab of the original D20 device configuration. 

12.2. Click the D20 device.

12.3. Click the ribbon Configure group > Edit > Properties.Result: A Warning prompts 
you to save an internal backup copy.

12.4. Click Yes to create a backup, or No to not create a backup.
Result: The D20 Device Wizard Basic Settings window appears.

12.5. Click Next until the Processor tab appears.

12.6. Click the Processor tab > General sub-tab.

12.7. From the Part Number field, click Select .
Result: The Select a Processor Card window appears.

12.8. Select one of the three D20MX processor type part numbers (526-3001, 526-
3003 or 526-3005). 

12.9. Click OK, Firmware tab, and Select .
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12.10. Select either SAN0001/132 or SAN0002/132 as per the decision taken in step 2. 
If you had opted to upgrade the firmware in ConfigPro, then this step is not 
necessary. 

12.11. Click OK.

12.12. Click Next and Finish.
Result: The D20 Device Wizard closes.
Note: This process can take awhile. Most of the warnings that occur at the end 
of this process disappear after the completion of Step 18.

13. Ensure the BOOTP client is disabled:

13.1. Click the Project tab of the original D20 device configuration.

13.2. Click the D20 device.

13.3. Click the ribbon Edit group > Properties.
Result: A Warning prompts you to save an internal backup copy.

13.4. Click Yes to create a backup, or No to not create a backup.
Result: The D20 Device Wizard appears.

13.5. Click Next until the Processor tab appears.

13.6. Click the LAN Settings tab > General sub-tab.

13.7. From the BOOTP Settings frame, ensure Not Used is checked.

13.8. Click Next and Finish.
Result: The D20 Device Wizard closes.

14. Disable unused applications:

14.1. Click the Project tab of the original D20 device configuration.

14.2. Double-click the D20 device.
Result: The Application List popup appears.

14.3. Press the Ctrl key and click on the applications you noted in step 10 as unused 
applications.
Result: The rows showing unused applications are highlighted.

14.4. If the configuration being transferred is a not LAN-based, also press the Ctrl 
key and click on B152-1N (IP Redundancy Monitor).

14.5. Click on Disable Application(s).
Result: A warning dialog appears.

14.6. Click Yes.
Result: The warning dialog and the Application list popup disappear.

15. Import the RADIUS roles from the D20MX default configuration into the D20 device:

15.1. Double-click the D20 device.
Result: The Application List popup appears.

15.2. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

15.3. Right-click the RADIUS Role Table icon and select Import .
Result: The Select source directory dialog appears.

15.4. Browse to the folder containing the exported RADIUS Role Table, select the file 
named B014RADR.CSV, and click Open.
Result: The WESMAINT II+ table icon set re-appears.

15.5. Double-click the RADIUS Role Table icon.
Result: The RADIUS Role Table editor appears.
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15.6. Compare the first column of the Access Flags sub-table (RADIUS Role Table > 
Application Control) to the following figure to confirm that the import was 
successful: 

15.7. Click OK, OK and Close.
Result: The WESMAINT II+ table editor closes.

16. If the D20 configuration being transferred is LAN-based, import the IP Redundancy 
Monitor point descriptors:

16.1. Click the Project tab of the original D20 device configuration.

16.2. Double-click the D20 device.
Result: The Application List popup appears.

16.3. Double-click the System Point Database application.
Result: The System Point Database Properties dialog appears.

16.4. Select IP Redundancy Monitor and click Descriptors.
Result: The Point Descriptors dialog appears.

16.5. Click on the Import button. 
Result: The Import Point Descriptors dialog appears.

16.6. Use the default settings for the Select Range of Points to Import and click OK.
Result: The Browse For Folder dialog appears.

16.7. Browse for the folder containing the exported IP Redundancy Monitor point 
descriptions and click OK.
Result: The Point Descriptors dialog appears.
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16.8. Confirm the point descriptors are as shown below.

16.9. Click OK, OK and Close.
Result: The main project window appears.

17. Change the baud rate of COM0 to 19.2K: 

17.1. Click the Project tab of the original D20 device configuration.

17.2. Double-click the D20 device.
Result: The Application List popup appears.

17.3. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

17.4. Double-click the Port Configuration table icon.
Result: The Port Configuration table editor appears.

17.5. Change the Baud Rate of COM0 to 19.2k. 
Result: The WESMAINT II+ table editor closes.

17.6. Click OK and Close.
Result: The main project window appears

18. Optionally, update the RADIUS and SYSLOG settings in B014-1N (WESMAINT II+): 

18.1. Click the Project tab of the original D20 device configuration.

18.2. Double-click the D20 device.
Result: The Application List popup appears.

18.3. Double-click the WESMAINT II+ application.
Result: The WESMAINT II+ table icon set appears.

18.4. Update the new tables: Remote RADIUS Servers Table, Remote Syslog Servers 
Table, TLS Auth Info Table, TLS CA Info Table, First PEM File Table, Second PEM 
File Table and Login Warning Banner Table, referring to the B014-1NCG 
WESMAINT II+ configuration guide.

19. If the configuration being transferred is LAN-based, generate the iSCS Configuration 
for the Project: 

19.1.  Click the Project tab of the original D20 device configuration.

19.2. Click: the D20 device.

19.3.  Click the ribbon Configure group > iSCS > Generate. 
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19.4. Confirm that there are zero errors in the Device Log; any Warnings are 
acceptable. 

20. If the configuration being transferred is not LAN-based, generate the configuration for 
the device:

20.1. Click the Project tab of the original D20 device configuration.

20.2. Click the D20 device. 

20.3. Click the ribbon Configure group > Configuration > Generate.

20.4. Confirm that there are zero errors in the Device Log; any Warnings are 
acceptable.

21. Review warnings:

21.1. Click the Project tab of the original D20 device configuration.

21.2. Click the D20 device.

21.3. Click the ribbon Configure group > Draw > select Output Window.
Result: The Device Log window appears.

21.4. Review all warnings and make corrections as needed, reviewing the backup 
copy to retrieve values that may have been replaced with default values during 
the transfer.

22.  Transfer the new configuration to the D20MX:

22.1. Click the Project tab of the original D20 device configuration 

22.2. Click: the D20 device. 

22.3. Click the ribbon Configure group > Communications > Options.
Result: The Device Communication Options widow appears.

22.4. Click Interface tab > Connection Type. 

22.5. Select Direct Serial and change the Communications Port to the serial port 
that is connected to the D20MX. 
Result: The Communications Options window shows that Connection Type is 
set to Direct Serial and the Communications Port is set to the serial port 
connected to the D20MX. 

22.6. Click the Port Settings tab and set the Baud Rate to 19200, and select the 
Software Transmit and Software Receive check-boxes. Then click OK. 
Result: The D2x Device Communications Options dialog closes. 

22.7. Physically connect the PC's serial port using the RS232 NULL modem cable to 
either the front serial port of the: 

– Standby D20MX, if the D20MX is configured for device redundancy, or 

– Standalone D20MX, if the D20MX is configured for standalone operation. 

22.8. Click the Configure ribbon group > Communications group > Connect . 
Result: The Terminal Emulator window opens. 

22.9. Login to the D20MX using the username admin and password changeme. 
Result: The D20M> prompt appears. 

22.10. Click the Configure ribbon group > Actions> Sync To. 
Result: The Downloading Configuration File dialog appears showing the 
progress of the download. At the conclusion, a Confirm dialog appears with 
three buttons: Boot, Verify and Exit. 

22.11. Click Boot . 
Result: The D20MX reboots with the new configuration. 
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NOTE

All users that existed in the transferred D20/D200 configuration now have the default 
password: changeme. Change these passwords using the passwd command in the D20MX 
Shell. Refer to the WESMAINT II+ for D20MX Configuration Guide B014- 0NCG for details of 
this command.

NOTE

If the D20MX was configured for device redundancy, once the sync to operation is 
complete, the standby unit reboots and comes up again as standby with the new 
configuration. If desired, switch over and synchronize the new configuration to the other 
unit through the “Switch Over” and “Database Sync” functions available in the WESMAINT 
System Functions menu. Refer to the WESMAINT II+ for D20MX User's Guide B014-0NUG 
for details on these functions.

Transferring a D200 configuration to the D20MX

Prerequisites Before you can transfer a D200 device configuration, the following components must be 
present:

• SGConfig 7.2 or higher installed on the configuration computer

• D200 Configuration has been migrated to SGConfig with the Migration Wizard (Refer 
to the Migration Wizard screencast).

Procedure

Migrating a multi-processor D200 only transfers the application configurations on the first 
processor.
This is manually resolved by moving applications from other processors to the first 
processor using the SGConfig device editing functions BEFORE converting the device to a 
D20 in the instructions below. 

Single and multi-processor D200 devices must first be changed into D20 devices before 
the D20MX processor card option can be selected. To change a D200 device into a D20 
device perform the following steps:

1. Start SGConfig.

Result: The Welcome to SGConfig screen appears.

2. Open a project containing the D200 device you want to transfer to a D20MX:

2.1. Click the GE button.

2.2. Click the required SGConfig project in the Recent Projects list or select the 
Open Project menu item.

3. Make a backup copy of the original D200 device configuration: 

3.1. Click the Project tab of the original D200 device configuration. 

3.2. Click the D200 device.

3.3. Click the ribbon Configure group > Edit > Copy.

3.4. Click a blank area on the page onto which the copy is to be placed. 

3.5. Click the ribbon Configure group > Edit > Paste.
Result: The Copying device window appears 
Result: Once completed a new device named COPY_OF_<original device 
name> or <original device name>_COPY appears.

4. Select the D200 device that needs to be changed to D20 and click the ribbon 
Configure group > Configuration > Change Type.

Result: The Change Device window appears.

5. Select type D20 and click OK.
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6. Follow the steps in section: Transferring a D20 configuration to the D20MX. 

Updating D20/D200 configurations to use the 
D20MX firmware definition with ConfigPro

Use this information to update the firmware definition of an existing D20 and D200 device 
configuration to the D20MX firmware definition. The result is a device archive that you can 
migrate into SGConfig for the purpose of transferring the D20/D200 configuration to the 
D20MX. The remaining steps of the transfer are described in “Transfer D20/D200 
configurations to the D20MX” on page 70.
If you are updating a D20 device configuration, follow the steps in section: Updating a D20 
configuration to use the D20MX.
If you are transferring a D200 device configuration, follow the steps in the following 
sections:

• “Updating a D200 configuration to use the D20MX firmware definition with ConfigPro” 
on page 82

• “Updating a D20 configuration to use the D20MX firmware definition with ConfigPro” 
on page 79

Updating a D20 configuration to use the D20MX firmware definition 
with ConfigPro

Prerequisites Before you can update the firmware definition of a D20 device configuration, the following 
components must be present:

• ConfigPro 5.03 or higher installed on the configuration computer.

Note: If you are using a ConfigPro version older than 5.03, skip this procedure and 
migrate your ConfigPro project archives directly into SGConfig. Then follow the 
procedure in section: “Transfer D20/D200 configurations to the D20MX” on page 70.

• D20MX Documentation CD (part number 588-0075 V132) in either of the following 
formats:

– Physical CD media, or 

– Zip file

Procedure To update a D20 or D200 device configuration to the D20MX:

1. Press the Windows Key  and E at the same time. 

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder is displayed.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder to D20MXV132.

Result: The folder is renamed to D20MXV132.

5. Access the D20MX Documentation CD files by either:

5.1. Insert the D20MX Documentation CD in to the computer’s DVD/CD drive, or
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5.2. Extract the D20MX Documentation CD zip file on to the root of your C: drive and 
double click the readme.html file under the ISO-Image sub-folder, which is 
nested two levels deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Result: Alternately for step 5.1, the home page does not appear in your default Web 
Browser. In this case, navigate to the CD in Windows Explorer, and double-click the 
readme.html file on the root of the CD.

6. Under the D20MX Factory Default Configuration Files section, click on the link 
named ConfigPro.

Result: The Factory Default Configuration Files folder is displayed.

7. Using Windows Explorer, copy/paste the files as shown in the following table. To copy 
a file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer window 
showing the new D20MXV132 folder and press Ctrl-V.

Result: The files shown in the above table appear in the new D20MXV132 folder of the 
Windows Explorer window.

8. Start Config Pro 5.03 or higher.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left.

9. Choose the D20MX Factory Default Configuration file, MX01-132.zip or MX02-132.zip. 
based on the following criteria:

– If transferring a configuration containing B009 versions greater than 310 and 
B021 versions greater than 912 use the file MX01-132.zip

– If transferring a configuration containing B009 versions less than or equal to 310 
and B021 versions less than or equal to 912, use the file MX02-132.zip.

10. If the MX01-132 or MX02-132 default configuration has already been imported, go to 
step 18. Otherwise, select from the menu bar Project > Archive Project > Restore.

Result: The Restore Project from ZIP File dialog appears

11. Under the Select Source Project ZIP File area, click the document icon.

Result: The Select a Project ZIP file to Restore dialog appears.

12. Navigate to the new D20MXV132 folder.

Result: The two files MX01-132.zip and MX02-132.zip appear in the dialog.

13. Select the appropriate file based on your decision made in the second step and click 
the Select button.

Result: The Restore Project from ZIP File dialog appears with the selected file showing 
under the Select Source Project ZIP File area.

14. Under the “Restore To” area, click the folder icon.

Result: The Select the Destination Project Directory dialog appears.

15. Navigate to your ConfigPro project folder on a hard drive of the configuration 
computer. The project folder is typically named C:\WESDATA.

Result: The contents of the project folder are displayed, and the file named 
WPL400.DB is selected.

16. Click the Select button.

Result: The Restore Project from ZIP File dialog reappears with the Project Directory set 
to the folder you selected in the previous step.

Navigate to folder on D20MX Documentation CD or 
Folder extracted from the Zip File

Copy/Paste the following files to the 
new folder D20MXV132

MX01-132.zip MX01-132.zip

MX02-132.zip MX02-132.zip



CHAPTER 5: CONFIGURING THE SOFTWARE

D20MX INSTRUCTION MANUAL GE INFORMATION 81

17. Change the Project Name if desired and click OK.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left . The new D20MX factory default project appears in the tree view.

18. Double-click on the D20MX factory default project.

Result: The Main Page of the D20MX factory default project appears with the FAC_DEF 
device placed on the page.

19. Double-click the FAC_DEF device.

Result: The Missing Applications! dialog appears.

20. Click the Install button.

Result: The Select the Source Application Definition Directory dialog appears.

21. Navigate to the DVD/CD drive > DEFNS > APPLDEF.

Result: The contents of the APPLDEF folder is displayed with the file DAL100.DB 
selected. 

22. Click Select .

Result: Messages are displayed about the application definitions being extracted to 
the configuration computer, and finally the Data Collection Applications of the 
FAC_DEF device appear.

23. Close the device configuration by clicking on the door icon.

Result: The Main Page of the D20MX factory default project appears with the FAC_DEF 
device appearing on the page.

24. Click from the menu bar, Device > Firmware.

Result: The Firmware Library dialog appears. 

25. Depending on which factory default project you chose in the second step, select either 
SAN0001/132 or SAN0002/132.

26. Click Copy.

Result: The Firmware Information dialog appears.

27. In the “Copy To” area select the Project Directory and Project Name of the project you 
want to transfer to the D20MX.

Result: The “Copy To” area contains the Project Directory and Project Name of the 
project you want to transfer to the D20MX.

28. Click OK, Close and the door icon

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left . 

29. Make a backup copy of your project.

29.1. Select from the menu bar, Project > Copy Project .
Result: The Copy Project dialog appears.

29.2. In the “From” area, navigate to the folder and select the project you want to 
transfer to the D20MX.

29.3. In the “To” area, enter a new unique name for the project.

29.4. Click OK.
Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left. 

30. On the tree view displayed to the left, navigate to the copied project and double-click 
on the project name.

Result: The main window of the copied project appears.

31. Right-click on the D20 device you want to transfer and select Properties.

Result: The D20 Device Properties window appears.
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32. Click the Processor tab and the Firmware tab. Then click Select .

Result: The Select a Firmware Type dialog appears. Depending on which factory 
default project you chose in the second step, either SAN0001 or SAN0002 appears.

33. Select whichever of SAN0001 or SAN0002 appears and click OK and OK.

Result: A confirmation dialog appears asking if you want to make a backup copy now.

34. Click No because you have already made a backup.

Result: Messages appear indicating the upgrade is in progress. Messages appear in 
the Device Log indicating the results of the upgrade. The D20 device appears with a 
red dot.

35. Review all warnings and make corrections as needed, reviewing the original copy to 
retrieve values that may have been replaced with default values during the upgrade

36. Right-click on the device and click Generate.

Result: The device is displayed without a red dot.

37. Right-click on the device and click Archive > Save.

Result: The Save Device to ZIP File dialog appears.

38. In the “Save To” area, click the folder icon.

Result: A dialog appears with the title “Select a directory in which to save the project”.

39. Navigate to a folder on your PC where you would like to save the device archive and 
click Select and OK.

40. Close ConfigPro.

41. Migrate the D20 Device Archive into SGConfig using the Migration Wizard (Refer to the 
Migration Wizard screencast).

Updating a D200 configuration to use the D20MX firmware 
definition with ConfigPro

Prerequisites Before you can update the firmware definition of a D200 device configuration, the 
following components must be present

• ConfigPro 5.03 or higher installed on the configuration computer.

• D20MX Documentation CD (part number 588-0075 V132) in either of the following 
formats:

– Physical CD media, or 

– Zip file

Procedure

Migrating a multi-processor D200 only transfers the application configurations on the first 
processor.
This is manually resolved by moving applications from other processors to the first 
processor using the ConfigPro device editing functions BEFORE converting the device to a 
D20 in the instructions below.
 
Single and multi-processor D200 devices must first be changed into D20 devices before 
the D20MX firmware definition can be selected. 
To change a D200 device into a D20 device perform the following steps:

1. Start ConfigPro 5.03 or higher.

Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left.
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2. Make a backup copy of the project you want to transfer to the D20MX.

2.1. Select from the menu, Project > Copy Project .
Result: The Copy Project dialog appears.

2.2. In the “From” area, navigate to the folder and select the project you want to 
transfer to the D20MX.

2.3. In the “To” area, enter a new unique name for the project.

2.4. Click OK.
Result: The main window of ConfigPro appears with the tree view of the project 
directory on the left. 

3. On the tree view displayed to the left, navigate to the project and double-click on the 
project name.

Result: The main window of the copied project appears 

4. Right-click on the D20 device you want to transfer and select Tools > Change. 

Result: The Change Device window appears.

5. Select type D20 and click OK.

6. Follow the steps in section: “Updating a D20 configuration to use the D20MX firmware 
definition with ConfigPro” on page 79. 

Software (feature) licensing

The D20MX application image file contains all the applications currently available for the 
D20MX. Some of these applications are licensed and are not available until they are 
unlocked.
These licensed applications are in groups, called application groups, and are identified by 
a license code.
Currently application groups 001 and 002 are available. Future releases of the application 
image file will provide more groups.
Use the D20M Shell command:

• swlic-report to view the list of application groups.

• swlic-list to view the applications in each group.

Enable trial period An application group may be temporarily enabled for a 30-day trial period.
To enable a trial, use the command swlic-trial -id 001 to enable application group 001. 
For example:

D20M> swlic-trial -id 001 
Trial license for '001' will be valid until 2013-03-18 (30 days)

Are you sure you want to enable the trial license for '001' [y/N] : y 
INFO : Trial License  '001' enabled until 2013-03-18

NOTE

The D20MX must be rebooted for the trial period to take effect

View the license 
status

The D20M Shell command swlic-report lists the status of the license. Each license group is 
listed.
For example:
D20M>swlic-report
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License Report Utility v01.000

License Information

==============================================================

Target Unit             : D20MX

Serial Number           : 526-3003-000001

Customer                : Utility ABC

License created from    : D400 Utilities V1.0.1

License Version         : 01.000

Application License                                     Status

==============================================================

001 : D2X Classic Applications                  Trial Disabled

002 : Advanced Automation Applications          Trial Enabled

Unlock an application 
group

To unlock an application group, an unlock code must be purchased from GE. Please 
contact Customer Service for the unlock code.
Customer Service asks for the 'Hardware Identifier' of the D20MX that is to have the 
application group unlocked. This is a unique identifier for each D20MX and cannot be used 
with any other D20MX (that is, the license is non-transferrable).

View the hardware 
identifier

Use the D20M Shell command swlic-info to view the Hardware Identifier.
For example:

D20M>swlic-info 
System Information 
License Information Utility V01.000

====================================================================

Target Unit                     : D20MX 
Hardware Identifier             : 303064303163306237323461 
License File                    : /tffs0/swLicense/license.key: Good

Customer Service sends you either:

• An unlock code

• An new license file (license.key)

• Or a batch file (batch.lic) which can be used on multiple D20MXs

Unlock code If Customer Service send an unlock code, use the D20M Shell command swlic-unlock -l 
<unlock code> to unlock the application group.
For example:

D20M>swlic-unlock -l 6E62385170303537533061626B66706643673D3D 
Unlock Key is Valid 
Info : License for '001' and been unlocked

This unlocks the application group 001.

License file If Customer Service sends a license file (license.key), use a SCP (Secure Copy) application, 
such as WinSCP, to copy the license file over the network to the /ram directory on the 
D20MX. 
Alternatively, use the D20M Shell RZ command to download the license file via Z-Modem 
through the console port. The RZ command automatically places the file in the /ram 
directory.
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NOTE

The file must be named license.key. 

Use the D20M Shell command CL (Copy License) to process the license file. This command 
copies the license file to the correct location on the D20MX, and if there are no errors, the 
D20MX automatically restarts.
For example:

D20M>cl 
Found License file (/ram/license.key) - copying 
copying file /ram/license.key -> /tffs0/swLicense/license.key 
License file copied  -- rebooting ....

Batch file If Customer Service sends a batch file (batch.lic), use a SCP (Secure Copy) application, such 
as WinSCP, to copy the batch file over the network to the /ram directory on the D20MX.
Alternatively, use the D20M Shell RZ command to download the license file via Z-Modem 
through the console port. The RZ command automatically places the file in the /ram 
directory.

NOTE

The file must be named batch.lic.

Use the D20M Shell command CL (Copy License) to process the batch file. This command 
processes the /ram/batch.lic file, extracting the appropriate license block and creates a 
new license file (license.lic). If there are no errors, the D20MX automatically restarts.

NOTE

For the batch file to be processed, a license file must be in place. Use the command swlic-
info to verify a license file is in place.

For example:

D20M>cl 
Found Batch file (/ram/batch.lic) - processing 
copying file /ram/batch.lic -> /tffs0/swLicense/batch.lic 
Batch License Installation '/tffs0/swLicense/batch.lic' 
Searching for serial number '526-3003-000001'' 
License Found in Batch File 
copying file /ram/newlicense.key -> /tffs0/swLicense/license.key 
Success : Success  License file updated
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Using the D20MX

The D20MX operation can be monitored and accessed through:

• Operational status LEDs

• LAN port status LEDs

• Fiber optic status port LEDs

Front panel LEDs 

Once the D20MX is powered up, the LED indicators on the front panel become active. The 
indicators provide status information on the operation of the D20MX.

Operational status LEDs
The status LEDs indicate the unit’s operational status:

LED Display Label Color Status Description

PWR Green Power
Solid light when 5 V DC power is correctly supplied to the 
processor board.
OFF when 5 V DC is not present.

RDY Green Ready
Flashes when Initialization (boot-up and self-diagnostics) of 
the D20MX is complete and the unit is ready to process data.

IRIG PWR

RDY

IRIG PWR

RDY
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LAN port status LEDs
The LAN Port Status LEDs provide a visual indication of the status for the Ethernet 
communication ports on the front of the D20MX. 

Fiber optic port status LEDs
The fiber optic port status LEDs provide a visual indication of the status for fiber optic ports 
1 and 2.

IRIG Green Flashes when an IRIG-B format time synchronization signal 
has been supplied to the unit and has been used to set the 
D20 system clock.
 
Note: When removing IRIG-B signal, the LED keeps blinking 
for up to a minute before turning off. 

Green Normally off; reserved for future expansion.

LED Display Label Color Status Description

IRIG PWR

RDY

IRIG PWR

RDY

IRIG PWR

RDY

LED Display Label Color Status Description

LINK Orange for 1000BASE-T.
Green for 10/100BASE-T

Link 1, Link 2
Solid light when an active device is 
connected to the Ethernet port.

ACT Yellow Activity 1, Activity 2
Flashes when data is transmitted or 
received on the channel.

LINK ACT

LINK ACT

LED Display Label Color Status Description

LINK 1
LINK 2

Green Link 1, Link 2
Solid light when an active device is connected to the fiber 
optic port.

ACT 1
ACT 2

Yellow Activity 1, Activity 2
Flashes when data is transmitted or received on the 
channel.

ACT 1 ACT 2

LINK 2LINK 1

ACT 1 ACT 2

LINK 2LINK 1
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Servicing the D20MX

The D20MX does not require scheduled maintenance. 
This chapter describes how to inspect the unit and remove the D20MX processor.

Performing periodic inspection 

Periodic inspection is recommended to ensure that:

• The device has sustained no accidental physical damage

• Connectors and cables are intact and firmly attached

Removing the D20MX processor module 

The D20MX can be removed from a non-VME (GE part number 500-0305) or VME (GE part 
number 500-0280) D20 chassis.

1. Ensure that you are sufficiently grounded to prevent ESD damage to the D20MX or 
other components. See section: “Grounding the D20MX” on page 52.

To remove the D20MX 
from a D20 chassis

1. Power down the D20 and disconnect the power supply.

2. Disconnect all communication cables from the front panel of the D20MX and the 
backplane of the D20 chassis.

3. Loosen the front panel retaining screws.

4. Remove the blank plates located above and below the D20MX.

5. Slide the D20MX partially out.

6. For the D20MX Non-VME with Dual 100Base-FX Fiber Optic Card (526-3005LF) only:

6.1. Disconnect the 975-1236 cable (connecting the fiber optic daughter card) from 
connectors J3 and J4 on the D20MX processor module.

6.2. Loosen the D20MX fiber card front panel retaining screws.

6.3. Carefully slide out the D20MX fiber card partially.
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6.4. Remove the 975-1236 cable through the middle slot in the chassis.

6.5. Store the D20MX fiber card in static-protective packaging.

7. Grasp the D20MX by the front handles and slide the processor module all the way out 
of the D20 chassis.

Allow the D20MX to cool before removing. The heatsink of the D20MX may be extremely 
hot during and immediately after operation. Use caution when removing the processor 
module from the chassis to avoid being burned. 

8. Store the D20MX in static-protective packaging.
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Removing Configuration Data and Sensitive Information from the D20MX

In the event that it is necessary to remove the configuration data and sensitive information 
from the D20MX (for example, disposal purposes), this chapter provides the procedure.
It may also be necessary to remove data from a PC that has run ConfigPro or SGConfig for 
the purpose of configuring a D20MX processor. Again, this chapter provides the data 
removal procedure. 

Remove configuration data and sensitive 
information from the D20MX

Prerequisites
Prerequisites for removing configuration data and sensitive information from the D20MX:

• A Windows PC with SGConfig 8.0 or higher software.

• A NULL modem cable (GE Energy part number 977-0529) connecting the RS-232 
connector on the front panel of the D20MX to the serial communications port of a PC 
or terminal.

Remove configuration data and sensitive information from the 
D20MX

To remove configuration data and sensitive information from the flash file system and 
NVRAM of the D20MX:

NOTE

The following procedure renders the D20MX unusable. Perform this procedure only when 
necessary (e.g., disposal purposes). If you wish only to return the D20MX to a system 
default state, refer to Chapter , Generating a System Default Configuration for the D20MX.

1. Set up Tera Term on a PC. See “Set up Tera Term on a PC” on page 64.

2. Restart the D20MX by turning the power off and on.

Result: The startup messages appear.

3. Wait for the following messages and press Ctrl-D.
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CPU type is ........................... MPC83xx (e300c1) 
Total SDRAM memory .................... 1 GB

Coherent System Bus Clock Running at .. 333.5 Mhz. 
System Bus (Memory) Clock Running at .. 166.6 Mhz. 
CPU Core Running at ................... 666.6 MHz.

Boot Type ............................. Cold

-----------------------------------------------------------

D20 Version 1.0.630-2238

Kernel built on Wed Dec 12 2012 11:06AM

-----------------------------------------------------------

Startup commands execution about to Begin...

Result: The D20> prompt appears.

4. Type the following command shown in bold font:

D20> fle 1 all

Result: The message “Erasing entire Flash Device” appears for about 7 minutes and 
then the D20> prompt appears.

5. Type the following command shown in bold font:

D20> nvramt

Result: Various messages appear and finally the D20> prompt appears.

6. Type the following command shown in bold font:

D20> efn

Result: The message “Erasing entire Flash Device” appears for about 1 minute and 
then the D20> prompt appears.

7. Power off the D20MX. The D20MX is now secured or disposal purposes.

Removing configuration data on a PC

If ConfigPro or SGConfig have been used to configure the D20MX processor, configuration 
data resides on the data storage media (e.g., hard drives, memory cards, etc.) of the PC 
running ConfigPro or SGConfig. 
The D20MX configuration data can be removed from the PC by either:

• Recommended:   Physically removing and destroying the data storage media., or 

• Using a program to securely wipe (i.e., completely erase) the data storage media; that 
is, not just reformat or remove the names of the files from the file allocation table. 
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 Default Role-Based Access Control Model 

Configured roles in the D20MX

When you configure the D20MX to use RADIUS, the D20MX must be configured with a set 
of roles in the B014 RADIUS Roles Table (B014RADR) of the WESMAINT II+ application (Refer 
to the B014-1NCG WESMAINT II+ for the D20MX Configuration Guide for more information). 
The role is identified by a role ID, which is an integer number provided by the RADIUS 
server. 
The D20MX Default configurations D20MX01-132 and D20MX02-132 include a default 
role-based access control model that meets the general rules shown in Table 22. 

Table 22: General access control rules

The Shell access level roles are provided in Table 23

Table 23: Shell access level

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

Can Change Passwords Yes No No No

Can Clear the Login Buffer No No No No

Can Change SCADA Settings Yes Yes No No

Can Download Firmware Yes Yes No No

Can Perform Operational Control (e.g. breaker 
operation)

Yes Yes Yes No

Can View Operational Data Yes Yes Yes Yes

Can Access Low Level “C” Shell Yes No No No

Description Administrator 
(2)

Engineer  
(1)

Operator 
(3)

Observer 
(0)

Access Level Read/Write Maintenance Read Only Read Only
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The specific flags defined in the Application Control field of the RADIUS Roles table are 
provided in the tables listed in Table 24.

Table 24: List of configured roles

Table Number Access Flags For... Associated 
Application #

Table 25 Modify WESMAINT 14

Table 26 Read

Table 27 Modify  D20AC WESMAINT II+ Display Screens 32045

Table 28 Read

Table 29 Modify Prologic display 36

Table 30 Read

Table 31 Modify DNP DPA Configuration Display 32021

Table 32 Read

Table 33 Modify Internet Statistics Display 162

Table 34 Read

Table 35 Modify DNP Serial Data Link Display 32013

Table 36 Read

Table 37 Modify Modbus DCA Display 59

Table 38 Read

Table 39 Modify Modbus DPA Display 68

Table 40 Read

Table 41 Modify File Upload Interface 32071

Table 42 Read

Table 43 Modify SOE Logger 27

Table 44 Read

Table 45 Modify SEL DCA 78

Table 46 Read

Table 47 Modify IEC 60870-5-101/104 DPA 101

Table 48 Read

Table 49 Modify Landis & Gyr 8979 DPA 185

Table 50 Read

Table 51 Modify Harris 6000/XA-21 DPA 199

Table 52 Read

Table 53 Modify IEC 60870-5 FT1.2 Balanced Data Link 32085

Table 54 Read

Table 55 Modify Modify access flags for DNP V1.00 Data Link 17

Table 56 Read

Table 57 Modify Quantum Meter Scanner DCA 18

Table 58 Read

Table 59 Modify CDC Type 1 DPA 23

Table 60 Read

Table 61 Modify PID DTA 41

Table 62 Read

Table 63 Modify MODBUS TCP DCA 131

Table 64 Read
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Table 25: Modify access flags for WESMAINT (Application number: 14) 

Table 26: Read access flags for WESMAINT (Application number: 14)

Table 65 Modify MODBUS TCP DPA 135

Table 66 Read

Table 67 Modify LogicLinx DTA 32082

Table 68 Read

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Time and Date display Yes Yes Yes No

1 Peripheral Status display Yes Yes Yes No

2 Peripheral Status Detail display Yes Yes No No

3 COS Buffer display Yes Yes Yes No

4 SHELL Yes Yes Yes No

5 Digital Inputs display Yes Yes Yes No

6 Digital Inputs Detail display Yes Yes Yes No

7 Digital Outputs display Yes Yes Yes No

8 Digital Outputs Detail display Yes Yes Yes No

9 Analog Inputs display Yes Yes Yes No

10 Analog Inputs Detail display Yes Yes Yes No

11 Analog Outputs display Yes Yes Yes No

12 Analog Outputs Detail display Yes Yes Yes No

13 Transition Counter display Yes Yes Yes No

14 Transition Counter Detailed display Yes Yes Yes No

15 SOE Buffer display Yes Yes Yes No

16 USER LOG display Yes No No No

17 Database Synch display Yes Yes Yes No

18 Switch-over display Yes Yes Yes No

19 System Status display Yes Yes No No

20 Communication Status display Yes Yes No No

21 Complex Object display Yes Yes No No

22 Complex Object Detail display Yes Yes No No

23 Generic Data display Yes Yes No No

24 Generic Data Detail display Yes Yes No No

25 - 31 Not used. Yes Yes No No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Time and Date display Yes Yes Yes Yes

1 Peripheral Status display Yes Yes Yes Yes

2 Peripheral Status Detail display Yes Yes Yes Yes

3 COS Buffer display Yes Yes Yes Yes

4 SHELL Yes Yes Yes Yes

5 Digital Inputs display Yes Yes Yes Yes

6 Digital Inputs Detail display Yes Yes Yes No

7 Digital Outputs display Yes Yes Yes Yes

Table Number Access Flags For... Associated 
Application #
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Table 27: Modify access flags for D20AC WESMAINT II+ display screens (Application 
number: 32045)

Table 28: Read access flags for D20AC WESMAINT II+ display screens (Application num-
ber: 32045)

Table 29: Modify access flags for Prologic display (Application number: 36)

Table 30: Read access flags for Prologic display (Application number: 36)

8 Digital Outputs Detail display Yes Yes Yes No

9 Analog Inputs display Yes Yes Yes Yes

10 Analog Inputs Detail display Yes Yes Yes No

11 Analog Outputs display Yes Yes Yes Yes

12 Analog Outputs Detail display Yes Yes Yes No

13 Transition Counter display Yes Yes Yes Yes

14 Transition Counter Detailed display Yes Yes Yes No

15 SOE Buffer display Yes Yes Yes Yes

16 USER LOG display Yes Yes No No

17 Database Synch display Yes Yes Yes No

18 Switch-over display Yes Yes Yes No

19 System Status display Yes Yes Yes Yes

20 Communication Status display Yes Yes Yes Yes

21 Complex Object display Yes Yes No No

22 Complex Object Detail display Yes Yes No No

23 Generic Data display Yes Yes No No

24 Generic Data Detail display Yes Yes No No

25-31 Not used. Yes Yes No No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operato
r (3)

Observer 
(0)

0 D20 AC Main Menu Yes Yes Yes Yes

1 Circuit Display Page Yes Yes Yes Yes

2 Circuit Configuration Page Yes Yes Yes Yes

3 D20 AC Configuration Page Yes Yes Yes Yes

4 – 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Connect to Prologic Editor Yes Yes Yes No

1 Request Control of Port Yes Yes Yes No

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)
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Table 31: Modify access flags for DNP DPA configuration display (Application number: 
32021)

Table 32: Read access flags for DNP DPA configuration display (Application number: 
32021)

Table 33: Modify access flags for internet statistics display (Application number: 162)

Table 34: Read access flags for internet statistics display (Application number: 162)

Table 35: Modify access flags for DNP serial data link display (Application number: 
32013)

Table 36: Read access flags for DNP serial data link display (Application number: 32013)

Table 37: Modify access flags for Modbus DCA display (Application number: 59)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-23 Not Used Yes Yes Yes No

24 Modify Points / Detail Displays Yes Yes Yes No

25-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 DNP DPA Display Yes Yes Yes Yes

1-22 Not Used Yes Yes Yes No

23 Configuration Pages Yes Yes Yes Yes

24 Detail Pages Yes Yes Yes No

25 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No
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Table 38: Read access flags for Modbus DCA display (Application number: 59)

Table 39: Modify access flags for Modbus DPA display (Application number: 68)

Table 40: Read access flags for Modbus DPA display (Application number: 68)

Table 41: Modify access flags for file upload interface (Application number: 32071)

Table 42: Read access flags for file upload interface (Application number: 32071)

Table 43: Modify access flags for SOE Logger (Application number: 27)

Table 44: Read access flags for SOE Logger (Application number: 27)

Table 45: Modify access flags for SEL DCA (Application number: 78)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

2 - 31 Not Used Yes Yes yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes No

2 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 1 Not Used Yes Yes Yes No

2 Gateway access to serial port Yes Yes Yes No

3 - 31 Not Used Yes Yes Yes No



APPENDIX A: DEFAULT ROLE-BASED ACCESS CONTROL MODEL

D20MX INSTRUCTION MANUAL GE INFORMATION 99

Table 46: Read access flags for SEL DCA (Application number: 78))

Table 47: Modify access flags for IEC 60870-5-101/104 DPA (Application number: 101)

Table 48: Read access flags for IEC 60870-5-101/104 DPA (Application number: 101)

Table 49: Modify access flags for Landis & Gyr 8979 DPA (Application number: 185)

Table 50: Read access flags for Landis & Gyr 8979 DPA (Application number: 185)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any Page Yes Yes Yes Yes

1 Not Used Yes Yes Yes No

2 Show relay level 1 password Yes Yes No No

3 Not Used Yes Yes Yes No

4 Show relay level 2 password Yes Yes No No

5 - 7 Not Used Yes Yes Yes No

8 Show MUX level 1 password Yes Yes No No

9-31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 Force / Unforce Point, Delete All or 
Delete to Cursor in SOE Log Display

Yes Yes Yes No

2 Freeze Accumulator Yes Yes Yes No

3 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Main Display Yes Yes Yes Yes

1 Analog Input Display Yes Yes Yes Yes

2 ADC Reference Display Yes Yes Yes Yes

3 Indication, SOE or Digital Input Display Yes Yes Yes Yes

4 Accumulator Display Yes Yes Yes Yes

5 SOE Log Display Yes Yes Yes Yes

6 Analog Output Display Yes Yes Yes Yes

7 Digital Output Display Yes Yes Yes Yes

8 LRU Configuration Display Yes Yes Yes Yes

9 Cross References Display Yes Yes Yes Yes

10 - 31 Not Used Yes Yes Yes No
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Table 51: Modify access flags for Harris 6000/XA-21 DPA (Application number: 199)

Table 52: Read access flags for Harris 6000/XA-21 DPA (Application number: 199)

Table 53: Modify access flags for IEC 60870-5 FT1.2 Balanced Data Link (Application 
number: 32085)

Table 54: Read access flags for IEC 60870-5 FT1.2 Balanced Data Link (Application num-
ber: 32085)

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 Not Used Yes Yes Yes No

2 Not Used Yes Yes Yes No

3 Force Digital Output (Digital Output 
Display)

Yes Yes Yes No

4 Not Used Yes Yes Yes No

5 Not Used Yes Yes Yes No

6 Force Analog Output (Analog Output 
Display)

Yes Yes Yes No

7 Force R/L Output (R/L Outputs Display) Yes Yes Yes No

8 Delete All COS (COS Display) Yes Yes Yes No

9 Delete All SOE (SOE Display) Yes Yes Yes No

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Main Display Yes Yes Yes Yes

1 Port Assignment and Cross References 
Displays

Yes Yes Yes Yes

2 Current Status Display Yes Yes Yes Yes

3 Digital Output Display Yes Yes Yes Yes

4 Accumulator Display Yes Yes Yes Yes

5 Analog Input Display Yes Yes Yes Yes

6 Analog Output Display Yes Yes Yes Yes

7 R/L Outputs Display Yes Yes Yes Yes

8 COS Display Yes Yes Yes Yes

9 SOE Display Yes Yes Yes Yes

10 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Not Used Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
[2]

Engineer 
[1]

Operato
r [3]

Observer 
[0]

0 Any Page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No
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Table 55: Modify access flags for DNP V1.00 Data Link (Application number: 17)

Table 56: Read access flags for DNP V1.0 Data Link (Application number: 17)

Table 57: Modify access flags for Quantum Meter Scanner DCA (Application number: 18)

Table 58: Read access flags for Quantum Meter Scanner DCA (Application number: 18)

Table 59: Modify access flags for CDC Type 1 DPA (Application number: 23)

Table 60: Read access flags for CDC Type 1 DPA (Application number: 23)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Update counters in the DNP Comm. 
Statistics Display

Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 DNP Comm. Statistics Display Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 1 Not Used Yes Yes Yes No

2 Update counters in Quantum Meter 
Status Display

Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Quantum Function Menu Yes Yes Yes Yes

1 Quantum Meter Data Display Yes Yes Yes Yes

2 Quantum Meter Status Display Yes Yes Yes Yes

3 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Main Menu Yes Yes Yes No

1 - 8 Not Used Yes Yes Yes No

9 Accumulators Display, 
Analog Inputs Display,
Direct Analog Outputs Display, 
SBO Analog Outputs Display, 
Direct Controls Display, 
SBO Controls Display,
Status Inputs Display, 
Direct Setpoints Display, and 
SBO Setpoints Display

Yes Yes Yes No

10 - 31 Not Used Yes Yes Yes No
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Table 61: Modify access flags for PID DTA (Application number: 41)

Table 62: Read access flags for PID DTA (Application number: 41))

Table 63: Modify access flags for the MODBUS TCP DCA (Application number: 131)

Table 64: Read access flags for the MODBUS TCP DCA (Application number: 131)

Table 65: Modify access flags for the MODBUS TCP DPA (Application number: 135)

Table 66: Read access flags for the MODBUS TCP DPA (Application number: 135)

Table 67: Modify access flags for the LogicLinx DTA (Application number: 32082)

Table 68: Read access flags for the LogicLinx DTA (Application number: 32082)

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Any page Yes Yes Yes Yes

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 SSH Port Forward Connect Yes Yes No No

1 - 31 Not Used Yes Yes Yes No

Bit 
Position

Description Administrator 
(2)

Engineer 
(1)

Operator 
(3)

Observer 
(0)

0 Wesmaint Connect Yes Yes No No

1 - 31 Not Used Yes Yes Yes No
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Standards & Protection

This Appendix lists the standards with which the D20MX has been tested for compliance.

Compliance standards

Compliance standards are listed for the following categories:

• Emission standards; see Table 69

• Immunity standards; see Table 70

• Safety publications; see Table 71

• Environmental standards; see Table 72

Table 69: Emission standards

Table 70: Immunity standards

Standard Name Description Test Specification

EN55011 (CISPR 11)1 ISM RF equipment – Electromagnetic 
disturbance characteristics

Radiated Emissions 30 MHz to 
1 GHz
Conducted Emissions 150 kHz – 
30 MHz

Standard Name Description Test Specification

IEC 61000-4-2 Electrostatic discharge (ESD) immunity 
test

Contact Discharge: 8 kV
Air Discharge: 15 kV
HCP and VCP: 8 kV 

IEC 61000-4-3 
IEC 61850-3: clause 5.7.2

Radiated, radio-frequency 
electromagnetic field immunity test

80 MHz to 1 GHz: 10V/m
1.4 GHz to 2 GHz: 3V/m
2 GHz to 3 GHz: 1V/m

IEC 61000-4-4 
IEC 61850-3: clause 5.7.1.4

Electrical fast transient/burst immunity 
test

Direct Couple: 4 kV/5 kHz
Capacitive Clamp: 2 kV/
5 kHz

IEC 61000-4-5 Surge immunity test
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Table 71: Safety publications

Table 72: Environmental standards

IEC 61000-4-6
IEC 60255-22-6
IEC 61850-3: clause 5.7.1.1

Immunity to conducted disturbances, 
induced by radio-frequency fields

150 kHz to 80 MHz: 10Vrms

IEC 60255-22-1 1 MHz burst immunity test

IEC 61000-4-8 Power frequency magnetic field 
immunity test

IEC 61000-4-9 Pulse magnetic field immunity test

IEC 61000-4-12 Ring wave

IEC 61000-4-11 Voltage dips, short interruptions and 
voltage variations immunity tests

IEC 61000-4-16
IEC 61850-3: clause 5.7.1.3

Test for immunity to conducted, common 
mode disturbances in the frequency 
range 0 Hz to 150 kHz

30Vrms, 300Vrms

IEC 61000-4-17 Ripple on DC input power port immunity 
test

IEC 61000-4-29+ Voltage dips, short interruptions and 
voltage variations on DC input power 
port immunity test 
This standard only applies when using 
high voltage DC as the source (100 V DC 
to300 V DC).

Standard Name Description Test Specification

IEC 61010-1 Safety requirements for electrical 
equipment for measurement, control and 
laboratory use - General requirements

IEC 60255-5 Insulation coordination for measuring 
relays and protection equipment- 
Requirements and tests

Dielectric and Resistance 
measurements not applicable 
due to design (TVS in circuit)

Standard Name Description Test Specification

IEC 60068-2-1 Cold 144 hours powered at - 20 °C

IEC 60068-2-2 Dry Heat 144 hours powered at + 70 °C

IEC 60068-2-6 Vibration (sinusoidal) A logarithmic sweep from 10 Hz to 
150 Hz to 10 Hz at 1 oct/min for 1 
sweep cycle in the 3 orthogonal axes.
Acceleration level 1 g

IEC 600255-21-2 Shock - Operating Response Test
Shock - Non-Operating Withstand 
Test

Pulse shape: Half sine Pulse duration: 
11 mS
-   Operating Response Test: 
Acceleration level: 5 g's
-   Non-Operating Withstand Test: 
Acceleration level: 15 g's
3 pulses per polarity per axis for a total 
of 18 pulses

IEC 600255-21-2 Bump – Non operating test Pulse shape: Half sine Pulse duration: 
16 mS Acceleration level: 10 g's
1000 pulses per polarity per axis for a 
total of 6000 pulses

IEC 60068-2-30 Damp heat, cyclic (12 h + 12 h 
cycle)

Standard Name Description Test Specification
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1 To comply, the ferrite clamp (460-0073) supplied must be installed on the power cable. 

IEC 60068-2-31 Drop and topple Dropping on each face Dropping on 
each corner Toppling (or pushover)
For a total of 12 drops

IEC 60068-2-78 Humidity Testing 96 hours steady state humidity at 40 °C 
and 93% RH

Standard Name Description Test Specification
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Frequently Asked Questions

This appendix answers some frequently and commonly asked D20MX questions:

• Why is a D20MX RTU important?

• How does configuration storage work in the D20MX?

• Why does the D20MX use the Vxworks Operating System instead of pSOS?

• Is the D20MX hardware backward compatible?

• Are the PCOMMON versions compatible with the D20MX?

• What is the recommended operating temperature range of the D20MX?

• What software application is used to configure a D20MX configuration?

• Can you migrate an old D20/D200 configuration to D20MX?

• What comprises a typical D20MX firmware upgrade?

• How do you upgrade the low-level firmware components of a D20MX?

• Can you migrate an old D20/D200 configuration to D20MX?

Questions and answers

Q: Why is a D20MX RTU important?

A: The D20MX is being introduced for the following reasons:

– Some electronic components used in the D20 products have reached their end-
of-life; For example, the 68EC030 CPU in the D20ME II and D20ME boards.

– VXworks is the new operating system for the D20MX; this is more robust for D20 
applications.

– The D20MX offers Cyber Security features that are intended for critical 
infrastructure protection within the power system. This is required for Electric 
Reliability Compliance.

– The D20MX is a modern platform that is capable of handling current and future 
processing needs, particularly for security. 

– The D20MX has 1 GB of RAM, compared to 1 MB RAM in the D20ME. 
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– The D20MX has 16 MB of built-in NVRAM, compared to the 512 KB of NVRAM 
available in its predecessor. Subsequently, there is no need for additional memory 
expansion modules. 

– The firmware flash memory size in the D20MX is 128 MB, compared to the 2 MB of 
its predecessor. 

– The D20MX uses a Super Capacitor which allows the system clock to be saved for 
14-days even after power off.

Q: How does configuration storage work in the D20MX?

A: The Super capacitor strictly allows the retention of the system clock time for 14-days. 
At power-up, the configuration resides in the RAM. At power-down, configuration 
resides in the flash. This is possible due to the seamless transaction between the RAM 
and flash. This arrangement protects the D20MX configuration from being lost, even 
after power-down for an indefinite period of time.

Q: Why does the D20MX use the Vxworks Operating System instead of pSOS?

A: Vxworks is designed for mission critical systems. It is purpose-fit , extremely robust 
and fast. It is industry-focused and designed from the ground-up to be a real-time 
operating system. It is the new operating system of choice for numerous embedded 
systems that require a high level of robustness.

A: Embedded systems manufacturers are moving away from the pSOS operating 
system since on-going support for this operating system is very limited.

Q: Is the D20MX hardware backward compatible?

A: The D20MX hardware is compatible with the I/O modules installed in the field.

A: Due to aging printed circuit board assembly and mechanical constraints, only certain 
chassis from 2002 and onward can be used with a D20MX. This comprises the 
following chassis:

– D20 VME chassis 500-0280 Release 08 or higher 

For the VME chassis 500-0280, the zero volt cable supplied with the D20MX KIT, 
must be connected from the zero volt TB2 terminal block on the 517-0225 to zero 
volt on the 517-0123. Review the hardware manual for the steps involved. Part 
number for the zero volt wire cable is 975-1237.

– D20 Non-VME chassis 500-0305 Release 18 or higher

Q: Are the PCOMMON versions compatible with the D20MX? 

A: The following PCOMMON versions are compatible with the D20MX:

– P022 v3.06, v3.05 and 3.00: PCOMMON for D20C 
 Note: v3.06 is required if fiber optic repeaters / splitters are used.

– P010 v3.06, 3.05, 3.01 and 3.00: PCOMMON for D20A, D20S and D20K

– P087 v1.04, 1.03 and 1.02: pBOOT for D20AC

A: Also see the PCOMMON versions compatible with the D20MX in Table 14 on page 34.

Q: What is the recommended operating temperature range of the D20MX?

A: The operating temperature range is 0°C to +70°C. 

Note:   Do not operate the D20MX above 60°C for extended periods of time as this 
shortens the life of the super capacitor and reduces the backup time of the real time 
clock.
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Q: What software application is used to configure a D20MX configuration?

A: The SGConfig (version 7.2 or higher) offline configuration tool is used to configure the 
D20MX. SGConfig is similar to ConfigPro which is used to program its predecessor.

Q: Can you migrate an old D20/D200 configuration to D20MX?

A: ConfigPro is partly used to get the D20 device configuration ready for migration into 
the SGConfig tool.

A: It is recommended to migrate a project rather than a device to prevent partial loss of 
configuration data related to Ethernet/LAN.

A: For detailed migration steps, see section “Transfer D20/D200 configurations to the 
D20MX” on page 70.

Q: What comprises a typical D20MX firmware upgrade?

A: Typically a firmware upgrade of the D20MX involves only the operating system and 
application firmware images, which are transferred by SFTP.

Q: How do you upgrade the low-level firmware components of a D20MX?

A: To upgrade the low-level firmware components (i.e., Bootrom, FPGA or JMON) of a 
D20MX run a TFTP client from the JMON prompt of the D20MX. Upgrading of these 
low-level firmware components is seldom required. 

Q: What comprises a typical D20MX firmware upgrade?

A: Typically a firmware upgrade of the D20MX involves only the operating system and 
application firmware images, which are transferred by SFTP.
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Using ConfigPro with D20MX

While SGConfig is recommended for configuring and transferring a D20 configuration to 
the D20MX, it is also possible to configure the D20MX using ConfigPro.
This appendix describes how to transfer a D20 configuration to the D20MX using 
ConfigPro. 
Refer to the “Application definition files and default configurations” on page 137 to see 
how application definition files and factory default configuration files can be installed.
Using ConfigPro to configure and transfer a D20 configuration to a D20MX is done by:

• “Transferring D20 configurations to the D20MX” on page 112

• “Downloading a D20MX configuration” on page 128
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Transferring D20 configurations to the D20MX

To transfer a D20 configuration to the D20MX using ConfigPro:

1. Create a D20MX device.

1.1. Right-click the D20 device. 

1.2. Select Copy….
Result: The Select Project and Page to Copy Device to window appears.

1.3. In the Device Name field, rename the device as a D20MX device.
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2. Generate a report of the applications in the original D20 device configuration and 
determine the unused applications.

2.1. Right-click on the created D20MX device and select Reports > Application List .
Result: The Select Reports dialog appears with the Application List report 
selected.

2.2. Click Setup.
Result: The Print Setup dialog appears.

2.3. Select a printer in the Name field if the Name field is empty. 
Result: A printer is selected in the Name field.

2.4. Click OK and OK.
Result: A new tab named Application List opens and contains the Application 
List report for the original D20 device.

2.5. Compare the Application List report with Table 2 D20MX application definitions 
on page 16. With the exception of IP Redundancy Monitor (B152-1), note the 
applications that appear in Table 2 but not in the report. You may want to print 
Table 2 and mark these applications. These applications are referred to as 
“unused” applications in the steps to follow.

2.6. Click the Door icon to close the Application List report.
Result: The project containing the created D20MX device reappears.

3. Edit the device properties of the created D20MX device so that it uses an appropriate 
D20MX SAN firmware file and it has similar device properties to the desired D20MX 
factory default configuration. 

The D20MX SAN firmware files exist in two forms:

– SAN0001 contains the latest versions of all applications and should be used in all 
new configurations.

– SAN0002 contains older versions of the Mailbox DTA [B009] and DNP v3.00 DPA 
[B021] and is required for systems with older applications. If transferring 
configurations containing B009 versions less than or equal to 310 and B021 
versions less than or equal to 912, use the file SAN0002 firmware. For more 
details, see Table 2, “D20MX applications,” on page 17.

3.1. Select the factory-based D20MX configuration file to be restored. 

3.1.1. Right-click the D20MX device. 

3.1.2. Select Archive > Restore.
Result: The Select a Device Zip file to Restore window appears.
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3.1.3. Navigate to the factory default configuration files which were staged 
previously. 
The listed factory-default configuration files with a .zip extension were 
built with ConfigPro.

3.2. Select a project location to which the configuration file is to be restored. 
Note: The D20MX factory default configuration files are ConfigPro 5 based. If 
using ConfigPro 6 or 7, when prompted to upgrade, select Yes. 

If a message indicates that a nested loop [project] is to be created, choose a 
different Project directory as required: e.g., C: drive in the screen capture that 
follows. 
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3.3. Open the restored factory default configuration file.

3.3.1. Navigate to the project directory where the factory default configuration 
was restored.

3.3.2. Open the file. 

3.3.3. Use the Projects and Windows tab to switch screen content. The 
Windows tab allows access to different projects. 

As shown above, the device properties of the factory default 
configuration MX01-132 uses SAN0001. 
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3.3.4. Right-click on the factory default configuration's main page and select 
Firmware.

3.3.5. Select the required SAN firmware and click Copy to transfer this firmware 
to the project location in step 1.

This is the location of the copy of the D20 device being modified. In 
step 1, this D20 device was copied and renamed as a D20MX device.
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Result: The D20MX device location now has a firmware library that 
contains the SAN firmware transferred from the previous step.

3.4. Select the D20MX device created in step 1 [copied and renamed D20 device], 
which is to use the intended SAN firmware in the firmware library.

3.4.1. Right-click on the D20MX device.

3.4.2. Select the Processor tab > Firmware tab > Use Firmware Type check-
box to choose the SAN0001 firmware. 
Result: The Select a Firmware Type window appears. Click OK.

3.4.3. Confirm the SAN0001/SAN0002 firmware is now associated to the 
D20MX device (from step 1).
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3.5. Manually set the D20MX processor card. 
Note: In the same device properties, the General tab does not include a D20MX 
processor card.

3.5.1. Manually set the memory model in the D20MX device being modified by 
selecting the Processor tab > Memory Model tab > Set Manually option.

Use the memory model settings from the factory default configuration as 
a reference, See the table below.

NOTE

Step 3.6 is applicable if the device configuration were a “LAN-based Device” 
configuration. LAN-based device in the device properties must first be selected under 
the main General tab. It is impossible to have a LAN-based device unless the project 
itself is a LAN-based project with all network addresses and settings clearly defined 
for LAN A and optionally B. Step 3.6 assumes that the reader is familiar with the 
complete ConfigPro LAN settings configuration steps and that these steps have 
already been considered. It points out the D20MX factory default LAN-settings.

3.6. Set the LAN Settings.
Default LAN-Based Important Settings:    Notice that the D20MX factory 
default configurations are LAN-based. This is because the hardware of the 
D20MX RTU has built-in LAN functionality by default. Subsequently, no extra 
Media Interface Card or EME card is needed. 

 D20MX Processor Memory Model - Set Manually

EPROM Base 60000000 [HEX] EPROM Size 10000000 [HEX]

NVRAM Base 50010000 [HEX] NVRAM Size 00FF0000 [HEX]

RAM Base 00000000 [HEX] RAM Size 40000000 [HEX]

No D20MX card 
choice from this list
 
Need to set a man-
ual memory map
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3.6.1. For LAN-based D20MX configurations, ensure that the BOOTP Settings 
option is disabled; select the Not Used option.

3.6.2. The Services settings highlighted below are used for remote connection 
into the RTU. If not included in the Services settings, the defaults for 
WesmaintSSH and CommandSSH are 22 and 922 respectively. If 
included, these ports can be changed to customized numbers:

– WesmaintSSH allows remote access to the wesmaint menu. 

– CommandSSH allows remote access to SFTP and the D20M shell. 

These are both TCP connections.

4. Click OK when the D20MX device properties are set.

Result: The applications present in the SAN firmware are applied to this new D20MX 
device. 
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5. Carefully configure the applications of interest before generating the tables for the 
D20MX device. Disable unused applications. as determined from step 2.

5.1. In the D20MX device from step 1, disable the unused applications identified in 
step 2. 
In addition, disable B152-0N IP Redundancy Monitor if the device is not LAN-
based.

5.2. Configure the Wesmaint II+ [B014-1N V630] and System Point Database [B008-
1 V3.11] applications. 

5.3. Configure the new Wesmaint II [B014-1N V630] application referring to its 
configuration guide. There are new tables and security settings that are 
required to be configured. For complete details, refer to the D20MX 
Documentation CD or extracted zip file for the B014-1N configuration guide.

5.3.1. Use the D20MX factory default configuration as a reference.

5.3.2. Double-click on this factory default configuration and click the System 
Point Database Applications tab. 
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5.3.3. Double-click on the Wesmaint II+ application. 

5.3.4. Import the RADIUS roles from the D20MX default configuration into the 
D20MX device being modified. 
While in the D20MX factory default configuration's Wesmaint II+ 
application, right-click on the RADIUS Role Table [B014RADR]. Export the 
settings to a location on a local drive. These settings are imported later 
into the same table in the newly modified D20MX device.
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5.3.5. While in the D20MX device created in step 1, double-click and go to the 
System Point Database tab which contains the Wesmaint II+ application. 
Right-click on the RADIUS Role Table [B014RADR] and import the 
B014RADR settings previously exported. Select the B014RADR.CSV file 
and click Select .

5.4. Configure the IP Redundancy Monitor [B152] application.
Note: If the IP redundancy [B152] application in the Data Translation 
Applications tab is enabled, its pseudo point descriptions must be correctly set. 
Complete the following steps to ensure this. 

5.4.1. Use the D20MX factory default configuration as reference.
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5.4.2. Double-click this factory default D20MX configuration and go to the 
System Point Database Applications tab. 

5.4.3. Double-click the System Point Database Applications Table. Select the 
IP Redundancy Monitor from the list of application and click Descriptors. 
Right-click the Export icon and export the descriptions of the six pseudo 
points. 
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5.4.4. Click OK. 

5.4.5. Choose a location to export these descriptions to. The text file exported is 
imported later into the new D20MX device being modified. 

5.4.6. Go to the D20MX device being modified. Double-click the device. 
Navigate to the System point database Applications tab. Double-click 
the System Point Database application. Select the IP Redundancy 
Monitor from the list of applications. Click Descriptors. Click the Import 
icon.
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5.4.7. Import the same text file [DIDESC.TXT] that was previously exported from 
the factory default D20MX device.

5.4.8. Confirm the pseudo point descriptions changed as shown below. Click OK 
to accept the change and to close each window.

5.4.9. Carefully configure all other enabled applications based on their 
respective configuration guides. This is required before a configuration 
can be successfully generated without errors. 
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5.4.10.Right-click the device and generate all the tables of the device. Carefully 
review and resolve all error and warnings. 
Note: A red dot on a device indicates that the device's tables need to be 
generated. Unresolved errors makes the red dot remains

5.4.11.Open up the device and go to the Wesmaint II+ application to compare 
the RADIUS Role [RADR] tables in the factory default D20MX device with 
that in the newly modified D20MX device. Compare the first two columns 
[Role ID and Role Name] as shown below to confirm the export and 
import was successful. If not, repeat the export/import process.

6. Generate the device configuration, after a configuration has been properly 
configured. 

Result: If there are no errors or warnings, the red dot on the device should not appear 
and the generated device is ready to be downloaded into the D20MX RTU. 

7. The transfer of a D20 configuration into a D20MX configuration is complete. 
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Configuration file in project directory

NOTE

In step 5.4.10, a D20MXDEVICE.SHX file was created after generating the tables of this 
D20MX device created. This file can be found within the device directory in windows 
explorer. 

The D20MXDEVICE.SHX file is the file downloaded into the D20MX during the configuration 
download process.
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Downloading a D20MX configuration

A D20MX configuration can be downloaded either through a:

• Local [Serial] Transfer of Configuration, or a

• Remote [Secure] Transfer of Configuration

Local [serial] transfer of configuration
The local transfer of configuration can be done by either:

• “Option 1 - use ConfigPro terminal emulator and the F7 key” on page 128

• “Option 2 - Use a non-ConfigPro terminal emulator and a “dl” command” on page 131

Option 1 - use 
ConfigPro terminal 

emulator and the F7 
key

Serial configuration download to the D20MX is done from within ConfigPro similar to a 
D20. 
To use a serial connection to download a configuration to the D20MX, using the ConfigPro 
terminal emulator and F7 key:

1. Connect a cable; either a: 

– NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector at the front panel of the D20MX to the serial communication port of the 
PC. 

OR

– Wesmaint cable [977-0300] could be used to connect the Wesmaint port at the 
back of the D20MX chassis to the serial communication port of the PC.

2. Set up the terminal emulator with the D20MX communications parameters.

2.1. From ConfigPro, select Device > Communications > Communications 
Options….
Result: The Communications Options window appears.
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2.2. Set the communication options:

– Baud Rate: 19200

– Parity: None

– Data Bits: 8

– Stop Bits; 1

2.3. Connect to the D20MX device. 

2.3.1. Right-click or click the device icon. 

2.3.2. Select Device > Communications > Terminal Emulator.

2.3.3. Login to the D20MX terminal using the login and password. When logging 
into the D20MX for the first time, use the default login and password 
[Login: admin | Password: changeme].
Result:   The D20M prompt appears.

2.3.4. Confirm that access is allowed by pressing the Enter key a couple of 
times.

2.4. Download [sync] the configuration from ConfigPro to the D20MX by pressing 
the F7 key on the key board. 

2.5. Optionally you can set up the terminal emulator for faster download speed:

2.5.1. Login to the D20MX device through the ConfigPro Terminal Emulator.
Result: The D20M prompt appears.

2.5.2. Type baud 115200 and press Enter. 
Result: The D20MX baud rate changes from 19200 to 115200.

2.5.3. Disconnect the D20MX from ConfigPro by selecting Communications > 
Disconnect .

2.5.4. Open the communication properties by selecting Device > 
Communications > Communications Options…. 
Result: The Communications Options window appears.
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2.5.5. Change the baud rate to match 115200 by selecting the Software 
Transmit and Software Receive options and then clicking OK.

2.5.6. Reconnect to and login to the D20MX. See step 2.3 [Connect to the 
D20MX device].

2.5.7. Download [sync] the configuration from ConfigPro to the D20MX by 
pressing the F7 key. 
Result: The Download Configuration File progress bar appears.

2.6. Restart the D20MX device when the download is complete by clicking Boot .

NOTE

Booting the D20MX resets it to 19200. If the baud rate in the D20MX is not the 
same as that in the communication properties, the command prompt shows 
the following characters. 

If this is the case, change the ConfigPro communication properties to match 
the 19200 baud of the D20MX.
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Option 2 - Use a non-
ConfigPro terminal 

emulator and a “dl” 
command

A D20MXDEVICE.SHX file is created when the tables of the D20MX device are generated. 
See section “Configuration file in project directory” on page 127 or see step 8 [Locate the 
D20MXDEVICE.SHX file] within this section.
Serially transfer the D20MXDEVICE.SHX file using Tera term (a terminal emulator) to the 
D20MX RTU using the dl command; this is similar to the download process of a D20ME 
firmware configuration. This download process is done at the D20M prompt. 
To download a configuration to the D20MX, using a non-ConfigPro terminal emulator and 
a “dl” command:

1. Connect a NULL modem cable (GE Energy part number 977-0529) from the RS-232 
connector located at the front panel of the D20MX to the serial communications port 
of the PC or terminal. 

2. Set-up a VT100 terminal emulator [e.g., Tera term Pro] with the following serial 
communication parameter values:

NOTE

To determine the computer port used, on the computer's desk top, right-click on the 
My Computer short-cut icon and go to Manage. Go to Device Manager > Ports as 
shown below. 

3. Login to the D20MX device. The factory default configuration for the D20MX comes 
with one default user account with: Username: admin; Password: changeme. 

Parameter Value

Port COM1 or COM2, or as required by the computer being used.

Baud Rate 19200 bps

Data 8 bit

Parity none

Stop 1 bit

Flow Control Xon/Xoff

Transmit delay 0   msec/char; 0 msec/line
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4. Navigate to the D20M prompt; this is called a SHELL prompt - an equivalent of the 68K 
monitor prompt. 

5. Press the Enter key a couple of time to display and confirm the required prompt; that 
is, D20M. 

6. Type sp to suspend the processor, then type dl to download and press Enter.

7. The D20MXDEVICE.SHX file located in the project directory below can simply be 
dragged and dropped in the Tera term window. 
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8. Locate the D20MXDEVICE.SHX file. 

8.1. Open Windows explorer.

8.2. Navigate to the project directory where this D20MX device is located. 
Note: The file name D20MXDEVICE represents the device name.

9. Drag and drop the D20MXDEVICE.SHX file onto the Tera term window. 

NOTE

Once a configuration download has been completed, it is recommended that the default 
user account information be changed as soon as possible. Refer to the B014-1NCG 
WESMAINT II+ for the D20MX - Configuration Guide for details on how to modify user 
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accounts and how to change the password of a user. The D20MX configuration can be 
defaulted by pressing CTRL-F on a terminal connected over the front RS232 port during 
startup. In addition, if the D20MX detects a corrupt configuration on startup, it generates a 
system default configuration. 
The system default configuration comes with one user account: username: recover; 
password: system. Login with this username and synchronize a configuration to the 
D20MX over the front RS232 port. 

NOTE

The D20MX can only be accessed over the front RS232 port with the system default 
configuration. 
If you synchronize a configuration with any of the following errors: “there are no 
usernames configured in the B014 User table”; “the B014 User table is disabled”, or “the 
B014 application definition does not match the firmware version”, then the applications do 
not start and you have only serial access in debug mode.

Remote [secure] transfer of configuration
Since Telnet and TFTP file transfer do not provide a secure means to connect or transfer 
data to the D20MX RTU, they are not supported within the D20MX. 
The D20MX now supports both SSH and SFTP means of connection. The D20MX RTU must 
be equipped with a valid IP configuration that allows computer PC connectivity. 
WinSCP is an example of a commonly used tool that allows connectivity to the D20MX 
remotely. This can be found on the web. WinSCP downloads are available at: 

http://winscp.net/eng/download.php 
To transfer the configuration file:

1. Set your computer IP address to be in the same domain [IP address and Subnet mask] 
as the D20MX.

2. Close any currently opened terminal session to the D20MX.

3. Start WinSCP.
Result: The WinSCP Login window appears.
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4. Login to WinSCP using the D20MX IP address and port number 922 or the configured 
CommandSSH port.

NOTE

In the D20MX configuration, port 922 has been created in the Services section of the 
Device LAN Properties as CommandSSH.

5. If the following window appears, click Yes.

6. Make a copy of the generated configuration file D20MXDEVICE.SHX and rename it to 
device.shx. 

7. Transfer the device.shx file by dragging it from your computer local drive into the 
D20MX's ram. 
Result: The Copy window appears.
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8. Click Copy.

9. Login to the D20M prompt of the D20MX RTU - this is the SHELL [option 3] menu. 

10. Suspend the processor by typing sp and pressing Enter. 

11. Copy the configuration by typing cc and pressing Enter. 

12. Select the configuration file by tying sc and pressing Enter.

13. Restart the D20MX device by typing boot and pressing Enter. 
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Application definition files and default 
configurations

The D20MX Documentation CD or extracted zip file contains numerous folders and files. 
The three main folders for the purpose of this document are highlighted below. 

The D20MX Documentation CD or extracted zip file contains all of the following:

•  Configuration guides, including the Wesmaint II+ user and configuration guides. 

• Factory Default Configuration files: Application Definitions/D20MXv1_3Appldefs. The 
ConfigPro sub-folder contains the factory default zipped ConfigPro files.

Staging factory default configuration files
To stage the factory default configuration files so that they may be accessed by ConfigPro:

1. Press the Windows Key  and E at the same time. 

Result: The Windows Explorer window appears.

2. Navigate to a folder to which you have write permissions.

Result: The content of the folder is displayed.

3. Click the New folder button in Windows Explorer

Result: A new folder is created with the name “New folder” and the cursor is positioned 
to allow renaming of the folder.

4. Rename the folder to D20MXV132.

Result: The folder is renamed to D20MXV132.

5. Access the D20MX Documentation CD files by either:

5.1. Insert the D20MX Documentation CD in to the computer’s DVD/CD drive, or

5.2. Extract the D20MX Documentation CD zip file on to the root of your C: drive and 
double click the readme.html file under the ISO-Image sub-folder, which is 
nested two levels deep into the extracted folder.

Result: The Documentation CD home page appears in your default Web Browser.

Result: Alternately for step 5.1, the home page does not appear in your default Web 
Browser. In this case, navigate to the CD in Windows Explorer, and double-click the 
readme.html file on the root of the CD.
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6. Under the D20MX Factory Default Configuration Files section, click on the link 
named ConfigPro.

Result: The Factory Default Configuration Files folder is displayed.

7. Using Windows Explorer, copy/paste the files as shown in the following table. To copy 
a file, select it and press Ctrl-C. To paste a file, click on the Windows Explorer window 
showing the new D20MXV132 folder and press Ctrl-V.

Result: The files shown in the above table appear in the new D20MXv132 folder of the 
Windows Explorer window.

Installing application definitions: archived
To install the application definitions:

1. From ConfigPro, initiate the Application Installer by selecting Tools > Application 
Installer.

Result: The ConfigPro Application Installer - Welcome window appears.

Navigate to folder on D20MX Documentation CD 
or Folder extracted from Zip File

Copy/Paste the following files to the 
new folder D20MXV132

MX01-132.zip MX01-132.zip

MX02-132.zip MX02-132.zip
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2. Select the Install all applications from archive option and click Next .
Result: The ConfigPro Application Installer - Select Archive window appears.

3. Select the source directory where the application archive is stored.

3.1. Navigate to the source directory: Go to the D20MX Documentation CD or 
extracted zip file folder > Configuration Files sub-folder > Application 
Definitions folder. 

3.2. Select the D20MXV1_3Appldefs file. 

3.3. Click Select . 

4. Click Next .
Result: The ConfigPro Application Installer - Select Destination Directory window 
appears.
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5. Select the destination directory into which the application definitions are to be copied. 
To determine the destination directory, in ConfigPro, go to File > Preferences > 
Directories. This is the path highlighted in the screen capture below 
[C:\WESSYS\ApplDef]
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6. Click Next .
Result: The ConfigPro Application Installer - Installation Complete window appears.

7. Click Finish.

Installing application definitions: non-archived
In the D20MX Documentation CD or extracted zip file, the DEFNs folder contains the 
APPLDEF sub-folder with all the application definition files.
To install missing application definition files:

1. From ConfigPro select Tools > Application Installer.
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Result: The ConfigPro Application Installer wizard appears.

2. Choose either of the following options:

– Install all the applications required in a project

– Install a number of applications YOU select.

3. Click Next .
Result: The ConfigPro Application Installer - Select Source Directory window appears.

4. Select a Source director [this is the DEFNs/ APPLDEF path within the D20MX 
Documentation CD or extracted zip file]. 
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5. Select the DAL100.DB file and click Select . The Definitions Found field should indicate 
Yes. 

6. Click Next .
Result: The ConfigPro Application Installer - Select a ConfigPro Project window 
appears.

7. Select the ConfigPro project that requires these application definitions. 

8. Click Next .
Result: The ConfigPro Application Installer - Select Destination Directory window 
appears.
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9. Select the destination directory into which the application definitions are to be copied. 
To determine the destination directory, in ConfigPro, go to File > Preferences > 
Directories. This is the path highlighted in the screen capture below 
[C:\WESSYS\ApplDef]

10. Click Next .
Result: The ConfigPro Application Installer - Installation Complete window appears.

11. Click Finish.
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D20MX Processor

Appendix E: Secure Connection for 
LogicLinx

Secure Connection for LogicLinx

This appendix provides the procedure to set up a secure connection to the D20MX for use 
with the LogicLinx editor in either ConfigPro or SGConfig. 
It is recommended that you use this procedure since it allows for strong security using the 
authentication, authorization and accounting model supported by other access points of 
the D20MX. 

Secure connection

The Windows* application 'PuTTY' (also known as “putty”) is used to establish an SSH 
tunnel from the LogicLinx editor running on the Windows PC to the LogicLinx application 
(B082) running on the D20MX. The establishment of an SSH Tunnel is also known as 'port 
forwarding'. At the time this procedure was published, the PuTTY Windows installer could 
be downloaded from:

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
To set up a secure connection to the D20MX for use with the LogicLinx editor:

1. Configure B014-1N Wesmaint II+ to grant the necessary privileges to allow the user to 
make connections to the LogicLinx application on the D20MX. 

Refer to section “Wesmaint user configuration” on page 146.

2. Configure B082-0N LogicLinx to require a secure connection. 

Refer to section: “LogicLinx (B082-0N) configuration” on page 147.

3. Establish the secure tunnel using PuTTY. 

Refer to section “PuTTY configuration” on page 148.

4. Configure the LogicLinx editor to use the secure tunnel. 

Refer to section “LogicLinx Editor configuration” on page 151.
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Wesmaint user configuration

In this procedure, a new local user “tom” is created and granted privileges to make 
connections to the LogicLinx application on the D20MX. If you are using remote 
authentication with RADIUS, the required privileges are available in the default settings of 
the Administrator or Engineer role.
To grant the necessary privileges to allow a local user to make connections to the 
LogicLinx application on the D20MX:

1.  View the Engineer role information from the RADIUS role table. 

In the Wesmaint II+ application:

1.1. Open the RADIUS Role table.

1.2. Select the row containing the role name “Engineer”.

1.3. Scroll right until you see the “Application Control” column. 

1.4. Double click the Application Control field for the Engineer role.

Result: A dialog showing the access flags for the Engineer role appears.

2. Copy the access flags from the Engineer role:

2.1. Select all of the rows up to the first row with a 0 in the Application Control field. 

2.2. Press Ctrl-C to copy the rows. 

Result: The access flags for the Engineer role as shown in the following screen are 
stored in the Windows clipboard.

3. View the access flags for a new local user:

3.1. Open the User Configuration table.

3.2. Add a new row and scroll left until you see the Application Control column.

3.3. Double-click the Application Control field.

Result: A dialog showing the access flags for the new user appears.
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4. Select the first row and press Ctrl-V to paste the application control flags from the 
Engineer role to the new local user.

Result: A dialog showing the Paste Options appears.

5. Click OK.

Result: The access flags for the Engineer role now appear in the new user's access flag 
list.

6. Click OK.

Result: The User Configuration table reappears.

7. For the Monitor Access Level field, select Maintenance. 

8. For the User Name field, type the name of the user, for example: tom. 

9. Click OK and OK.

Result: The Wesmaint User Configuration is closed.

LogicLinx (B082-0N) configuration

To configure B082-0N LogicLinx to require a secure connection:

1. In the Logic Linx (B082-0N V400) Communication Types configuration table set:

a)    Communications Type:     Ethernet

b)    SSH Tunnel:     Tunnel Enabled

c)    Port Number:    1100

NOTE

The Port Number may be any unused port number on the D20MX between 1 and 
65535.

Result: The LogicLinx configuration appears as shown in the following screen.

2. Generate and synchronize this configuration to the target D20MX.
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PuTTY configuration

To establish a secure tunnel using PuTTY:

1. Start PuTTY.

2. In the PuTTY Configuration dialog box, select Connection > SSH > Tunnels.

2.1. Under Port forwarding leave Local ports … and Remote ports… unchecked.

2.2. Under Add new forwarding port: in the Source Port box type 1100, or any free 
TCP port number on your PC.

2.3. In the Destination box, type the IP address 127.0.0.1:1100, where 1100 is the 
port number set in the LogicLinx configuration (refer to step 1 in the: “LogicLinx 
(B082-0N) configuration” section). 

2.4. Click the IPv4 radio button.
Result: The PuTTY Configuration dialog box appears as in the following screen: 
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2.5. Click the Add button.
Result: The PuTTY Configuration dialog box appears as in the following screen:

3. In the PuTTY Configuration dialog box, select Connection.

3.1. In the Seconds between keepalives ... box, type 10.
Result: The PuTTY Configuration dialog box appears as in the following screen:

4. In the PuTTY Configuration dialog box, select Session. 

4.1. In the Host Name box type the address of the target D20MX, for example: 
192.168.230.100.
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4.2. In the Port box type the configured commandSSH port number on the D20MX 
(for example, 922).

4.3. Under Connection Type, select SSH.

4.4. Type a name in the Saved Sessions box (for example, PortFrw) and click Save.
You may use the saved session the next time a secure connection is needed 
and avoid having to re-enter the PuTTY configuration settings.
Result: The PuTTY Configuration dialog box appears as in the following screen:

4.5. Click the Open button.
Result: A Terminal window appears.
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5. Login as tom.

Result: The Login Banner appears and the D20M> prompt appears as shown in the 
following screen:

NOTE

Leave the PuTTY window open throughout a debugger session or back-to-back 
debugger sessions. Once you are all finished running the debugger, close the PuTTY 
window to close down the SSH tunnel. 

NOTE

When Tom logs in, a connection event is added to the User Log:. For example:

6 13/12/18 11:15:46 <Net OK > tom (SSH) - 
originip="192.168.230.120" originMac="D8:9D:B9:00:0B:9C"

LogicLinx Editor configuration

To configure the LogicLinx editor to use the secure connection:

1. Start ConfigPro or SGConfig using “Run As Administrator”.

2. Open the Project containing the target D20MX device.

3. If using ConfigPro, open the target D20MX device.

4. Start the LogicLinx editor:

4.1. If using ConfigPro, right click on the LogicLinx icon under the Data Translation 
Applications tab and select Tools > LogicLinx Editor.

4.2. If using SGConfig, click LogicLinx under the Automation Applications node of 
the Applications List, and then click the LogicLinx Editor icon.
Result: The LogicLinx - Project Management window appears.

5. Double click the program icon or its name (e.g. main).

Result: The LogicLinx Programs window appears.

6. Click the Link Setup  icon.

Result: The PC-PLC link parameters dialog appears.

7. Set the Communication port box to ETHERNET.

Result: The PC-PLC link parameters dialog appears as in the following screen:
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8. Change the Ethernet link parameters:

8.1. Click the Setup button.

8.2. Type 127.0.0.1 into the Internet address box.

8.3. Type the port number you entered in step 2.2.of section “PuTTY configuration” 
into the Port number box (for example: 1100).
Result: The ETHERNET link parameters dialog appears as shown in the following 
screen:

8.4. Click OK.

9. Connect the debugger by clicking the Debug  icon.

Result: The LogicLinx Debugger window appears and is connected to the target 
D20MX.

NOTE

When Tom connects to the target D20MX, a port forward event is added to the User 
Log:. For example:

7 13/12/18 11:15:50 <SPF OK > tom (SSH) - Destination Port 
FW:127.0.0.1:1100
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List of Acronyms

Acronym Definitions

This Appendix lists and defines the acronyms used in this manual.

Table 73: Acronym list

Acronym Definition

A Amperes, unit of measure

AEL Accessible Emission Limit

ANSI American National Standards Institute

ASCII American Standard Code for Information Interchange

ASDU Application Service Data Units

AWG American Wire Gauge, unit of measure

bps bits per second, unit of measure

CCU Central Control Unit

CE Mark Mandatory conformity mark for products placed on the market in the 
European Economic Area (EEA)

CISPR Special international committee on radio interference

COM1/COM2 Communications port

CPU Central Processing Unit

CTS Clear To Send

dBm decibel-milliwatt, unit of measure - an electrical power unit in decibel (dB)

DCA Data Collection Application

DCD Data Carrier Detect

DNP Distributed Network Protocol

DPA Data Processing Application

DST Daylight Saving Time

DTA Data Transmission Application

DTE Data Terminal Equipment

EIA Electronic Industries Alliance
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EMC Electromagnetic Capability

EMI Electromagnetic Interference

EPUP Environmental Protection Use Period

ESD ElectroStatic Discharge

EU European Union

FEFI Far End Fault

FPGA Field-Programmable Gate Array

GE General Electric

GOF glass optical fiber

HCS Hard Clad Silica

HDLC High-level Data Link Control

HMI Human Machine Interface (also called Graphical User Interface – GUI)

Hz Hertz, unit of measure for frequency

I/O Input/Output

IEC International Electrotechnical Commission Standards

IED Intelligent Electronic Device

ILS Instrument Landing System

in-lb inch-pound, unit of measure for energy

IRIG-B Inter Range Instrumentation Group (IRIG) - an American standardized network 
time code format

kbps kilo bits per second, unit of measure

LAN Local Area Network

lb pound, unit of measure for weight

LC Lucent connector; A type of fiber-optic cable connector

LED Light Emitting Diode

LLA Loss Link Alert

LRU Logical Remote Unit

Mb Mega bits, unit of measure

MB Mega bytes, unit of measure

Mbps Mega bits per second, unit of measure

MBps Mega bytes per second, unit of measure

MCV Maximum Concentration Values

MD5 Message Digest 5 (check data integrity)

MDI Medium Dependent Interface

MDIX Medium Dependent Interface, Crossover

ms milliseconds, unit of measure

Nm Newton-meter, measure of energy

NTP Network Time Protocol

NVRAM Non-Volatile Random Access Memory

PC Personal Computer

PCBA Printed Circuit Board Assembly

PG&E Pacific Gas and Electric

PID Proportional, Integral and Derivative

PIM Privileged Identity Management

PPM Parts Per Million

pSOS Type of operating system

RMA Return Merchandise Authorization

Acronym Definition
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RoHS Restriction of Hazardous Substances

RTC Real Time Clock

RTS Request To Send

RTU Remote Terminal Unit

Rx Receive

RXD Receive Data

SCADA Supervisory Control and Data Acquisition

SCP Secure Copy application

SEL Schweitzer Engineering Laboratories

SNTP Simple Network Time Protocol

SOE Sequence Of Events

SQL™ Structured Query Language

SRU Sub-Remote Unit

ST Straight Tip connector; A type of fiber-optic cable connector

TIA Telecommunication Industries Association

Tx Transmit

TXD Transmit Data

UART Universal Asynchronous Receiver-Transmitter

UTC Universal Time Coordination

UTP Unshielded Twisted Pair

VA Volt Amps, unit of measure

V AC Volts, Alternating Current, unit of measure

V DC Volts, Direct Current, unit of measure

VME Versa Module Eurocard

WinSCP Windows Secure CoPy

Acronym Definition
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Appendix G: Miscellaneous

Miscellaneous

This appendix provides the warranty and revision history.

Warranty

For products shipped as of 1 October 2013, GE Digital Energy warrants most of its GE 
manufactured products for 10 years. For warranty details including any limitations and 
disclaimers, see the GE Digital Energy Terms and Conditions at  
https://www.gedigitalenergy.com/multilin/warranty.htm

For products shipped before 1 October 2013, the standard 24-month warranty applies.

Revision history

Version Revision Date  Change Description

1.00 0 October 17, 2012 Original release of this document. 

1 November 6, 2012 Updated D20 applications table and added Firmware/FPGA versions 
table.

2 November 23, 2012 Added sections for: Update to the SAN0001 firmware option, Transfer 
D20/D200 configurations to the D20MX, and Updating D20/D200 
Configurations to use the D20MX firmware definition with ConfigPro.
Added an Appendix for Resetting a read/write user password.

3 January 11, 2013 Updated procedures for configuring redundant D20MX devices in the 
Software Configuration chapter.

1.10 0 March 1, 2013 Updated the D20MX applications table.
Added Migrate D20MX application definitions to SGConfig section.

1.20 0 July 15, 2013 Updated the D20MX application tables, order code table, upgrade kit 
order code table, procedures in Chapter 5, and Added Appendix D. 

1.21 0 September 13, 2013 Updated for firmware version 1.21. 

1.30 0 January 7, 2013 Renamed to the D20MX Instruction manual.
Added Chapter 8: Removing Configuration Data and Sensitive 
Information from the D20MX.
Added Appendix E: Secure Connection for LogicLinx.
Updated for firmware version 1.30. 

https://www.gedigitalenergy.com/multilin/warranty.htm
https://www.gedigitalenergy.com/multilin/warranty.htm
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1.31 0 March 13, 2014 Updated for firmware version 1.31. 

1.32 0 May 9, 2014 Updated for firmware version 1.32. 

Version Revision Date  Change Description
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